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Symbol Description 

 
Note: pay attention to the user manual 
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 Important information 
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1 Introduction 
Biocrates’® proprietary MetIDQ™ software is an integral part of Biocrates® Kits. The software 
enables an automation of the assay workflow, from sample registration and data processing 
through data export and statistical data analysis. 

1.1 MetIDQ™ Requirements 
 Specifications and Requirements 

Operating system Windows™ 7 or higher, 64-bit architecture 

Hardware 
- 1 GHz processor 
- 4 GB RAM 
- 20 GB free hard disk space 

Additional software 
requirements 

- Microsoft™ .NET Framework 4.5.2 or higher 
- Microsoft™ Visual C++ Redistributables: 2005, 2008, 2010, 2012, 2013 

 

Oracle® Database (either) 
- Oracle® Database 11g, 12c, or 18c 
- Oracle® Database 18c Express Edition (installer provided with the kit) 

 Oracle® Database 18c Express Edition needs a mini-
mum of 10 GB additional free hard disk space 

 

 

 

Microsoft™ .NET Framework and Microsoft™ Visual C++ Redistrib-
utable installers are provided with the USB stick and will be installed 
during the first MetIDQ™ installation. 
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1.2 Software Information 
Data is managed and graphically presented using Biocrates’ proprietary MetIDQ™ software. 
The MetIDQ™ software is a desktop application with two components: MetIDQ™ software 
and an Oracle® relational database called “METKIT”. Kit data is stored in an Oracle® database. 
The USB stick in the Kit box contains both the MetIDQ™ software as well as files needed to 
install and to set up the Oracle® database. For faster installation, copy the USB stick contents 
onto a hard drive or server and install from there. Keep the USB stick as a backup. MetIDQ™ 
is not used during mass spectrometer data acquisition. It is used for MS data quantitation and, 
if required, importing result files from the LC part into the MetIDQ™ database after data ac-
quisition. 
 

 

To avoid data loss, perform regular MetIDQ™ database backups. Save the 
backup file (.dmp) at a secure place (network drive, external hard drive, USB stick) 
physically separated from the PC on which the database is installed. 
 Refer to section 7.6.1 Database Backup / Export on page 143 

 
Disclaimer – Oracle® XE 
The Oracle® XE database which is provided with the Kit is from a third-party provider (Oracle®). 
The Oracle® XE version is free of charge and no support is provided by Oracle®. If you have 
higher safety requirements in your company, we recommend using a commercial version of 
the Oracle® database, for which updates and support are provided by Oracle®. 
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1.3 Video Tutorials and FAQ 
In addition to this user manual, MetIDQ™ video tutorials are available on 

Biocrates® YouTube channel. 

 

Whenever you will see the YouTube icon, a video tutorial is available for 

the corresponding section or topic. Click the Help button  in MetIDQ™ 
or use the links provided in this manual. 

 

Comprehensive and up to date descriptions to Frequently Asked Questions can be found in 

Biocrates® FAQ section. 

https://www.youtube.com/channel/UCps9fJHFhaU1-KCej8h24_w
https://support.biocrates.com/tiki-index.php
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2 Install MetIDQ™ and Oracle® 
The installation of MetIDQ™ and all required software is done in the following step. The 
MetIDQ™ installation wizard guides through this process. 
 

1) Installation of MetIDQ™ and Oracle® (onto local PC) 
2) Import of kit database into Oracle® 
3) Installation of Windows™ runtime components 

 

 To update MetIDQ™ refer to appendix 7.5 MetIDQ™ Software Update. 

Information Oracle® Database 

There are two installation options (see table below). 

Condition Option 

No Oracle® database installed. 

The Oracle® Database Express Edition (Oracle® XE) can be installed 
during the MetIDQ™ installation. For multiple users we recommend 
a server installation, but you can also install Oracle® XE locally on a 
standard PC. 
Note: If Oracle® XE is installed locally, an installation on the MS op-
erating computer is not recommended. For best performance, install 
MetIDQ™ and Oracle® on a PC reserved for data analysis. 

Oracle® database already in-
stalled and in use. 

An Oracle® database administrator (DBA) imports the metkit data-
base from the USB stick. Refer to appendix 7.7. 

 

 
Before installing Oracle® XE make sure that an Oracle® database is not already installed. 

Note: During the installation of Oracle® all existing Oracle® databases are erased! 
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Software Support Policies 

Biocrates® will offer support for software published by Biocrates®. Support for software pub-
lished by third-party providers cannot be offered. Please find our support policies below. 
 

Software Support 

MetIDQ™ 
(incl. installation and setup) 

Full support provided 

Oracle® database 
No support provided, 
except initial setup during 
MetIDQ™ installation.  

To avoid data loss, perform 
regular backups according to 
section 7.6.1. 

Data backup and data loss No support provided 

Software of MS vendor, e.g. 
Analyst®, MassLynx™, 
Xcalibur™, MassHunter™ 

No support provided 
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2.1 Install the MetIDQ™ Software 
Step Instructions Example 

 
Full administrator privileges are required! 

 
MetIDQ™ and all installation files are provided with the kit USB stick, folder 
“MetIDQ and Oracle\Installation Files” 

 MetIDQ™ installation 

1 
Run the MetIDQ™ installation file with full ad-
ministrator privileges. Follow the installation 
instructions on the screen and below. 

 
MetIDQ-…-install-64bit.exe 

 

2 

A summary of the required software is shown. 
 
When MetIDQ™ is installed for the first time, 
Oracle® XE, the kit database, and Windows™ 
runtime components (e.g. C++ redistributable 
2013) are installed. 

 

 Oracle® XE installation 

3 
A license agreement is displayed. Confirm the 
default installation directory. 
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Step Instructions Example 

4 

Specify an Oralce® database password. 
Note: Document this password! 

You will need it for future database 
backups and upgrades. 

The password may not contain any special 
characters! 
 

Your Oracle® administrator password: 

_______________________________ 
 

 

5 Check the settings and start the installation.  

 Windows™ runtime components installation 

6 
Required Windows™ Visual C++ Redistribut-
able runtime components are installed one by 
one. 
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Step Instructions Example 

 Import of Kit Database 

7 
Enter the Oracle® database password, speci-
fied in step 4. 
Click “Next”. 

 

8 
An import dialog is opened. To confirm the set-
tings type “y“ and press Enter. 
The import process starts.  

 

The import process may take several minutes. Wait until this message is displayed: 
“Installation of database backup feature completed! Press any key . . .“! 

 

9 
After the import process, close the window by 
pressing any key. 
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2.2 Start the MetIDQ™ Software 
Step Instructions Example 

1 Start MetIDQ™. 
 

2 
Check the database connection: 

Click on the connections button . 

 

3 
Select the “Kit Database”. 

Click “Edit” . 
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Step Instructions Example 

4 

Kit Database connection settings are shown. 

 

Oracle® installed on local PC (default) 

• Host: localhost  or computer name 
• Service:  xepdb1  for Oracle® 18c XE 
•  xe for Oracle® 11g XE 
• Password: metk it  
• Other settings, see on right. 

Oracle® installed on server  

• Con. Name: freely selectable 
• Host: IP or DNS name of server; 

 localhost , for local installation 
• Service: SID or service name 

 XE , for local installation 
• User Name: default metk i t  
• Password: default metk i t  
• Port: default 1521  

 

 

Support by local network administrator may be required. 
 

- If Oracle® is installed on another PC or a server, define the IP address or name of 
the PC or server in the field “Host”. 

- If Oracle® XE is not used, define the used Oracle® service ID in the field “Service”. 
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Step Instructions Example 

5 

Connect with the Kit Database. 
 

Default log-in: 
 

Username: labadmin 
Password: 12345678 

 

6 

Request a MetIDQ™ License. 
 

The first time you start MetIDQ™, please request a 
license. Enter your contact information. Mandatory 
fields are marked with a “*“. 
 

Click  
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Step Instructions Example 

7 

 

A direct license request via internet may not 
be possible. Please send the license request 
file (.xml) by e-mail to us.  

Save the license request file (.xml) and send it to 
license@biocrates.com. 

  

Licenses are generated manually on work-
ing days in Austria (Central European Time). 
Please contact the Customer Support team 
for your personal licensing date. 

8 

Load a MetIDQ™ License. 

• After receiving a license, start MetIDQ™. 

• In the License Window click on “Load License”. 

• Select the provided file “license.xml”. 

• Store the license. 

 
 

 
 

 

mailto:license@biocrates.com
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Step Instructions Example 

9 

Apply a patch. 

• Log-in to MetIDQ™  

• Install a database patch, provided with the USB stick, 
folder “MetIDQ and Oracle\Patches”. 

• Install the appropriate patch for the kit and used MS instrument. This information are in-
cluded in the patch file name:   MSmanufacturer_KIT_DB###_Patch_YYMMDD.jar 

 

Example: 
 

Kit: p180 
MS instrument: SCIEX 
Patch: SCIEX_p180_DB108_Patch_180517.jar 
 

 
MetIDQ: User Interface, Barcodes and Patches 

10 
For more details how to load database patches 
please refer to section 7.7.  

 

MetIDQ™ uses barcodes, which are provided by Biocrates® free of charge. Barcodes are 
linked with samples and plates. The file “barcodes.xml” containing 3,000 barcodes is provided 
together with the license. 

11 

Import barcodes. 

• Open the Settings. 

• Select tab General. 
 
 

 

12 Click “Import barcodes”.  

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

13 Click No in the dialogue box. 

 
14 Select the file “barcodes.xml“ and click Open.  

 

If less than 300 barcodes are available, a warning 
message is shown. To request more barcodes, 
send an e-mail to: license@biocrates.com. 

  
Barcodes may be available via internet, if not 
blocked by network security settings. 

 

To check the number of available barcodes, go to 
Settings > General. 
The number of barcodes available is displayed, 
e.g. 346. 

 
 

 

 

15 

A Laboratory Administrator may create new user 
profiles and assign user roles based on the Met-
IDQ™ tasks the user will perform. Click on the 
User Admin icon in the MetIDQ™ toolbar. 

 

16 
To register a new user, click New in the User Ad-
min window 

 

mailto:license@biocrates.com
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Step Instructions Example 

17 

To create a new user profile, fill in all fields in the 
New User window. Select one or more check 
boxes to define User Roles for the new user. The 
default User Role is Laboratory Administrator (rec-
ommended). Click OK. 
 
Note: To apply “User Roles” changes restart Met-
IDQ™. 

 
 

 User Role Tasks 

 Laboratory Administrator Can perform all MetIDQ™ tasks. 

 Scientist Restricted user rights. 
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3 Using MetIDQ™ 
This chapter describes all essential and additional functions of MetIDQ™. 

 
MetIDQ: User Interface, Barcodes and Patches 

3.1 MetIDQ™ Screen Elements 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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3.2 General Software Features 
Explanation Example 

Filter: 

If no filter is set, the Filter button is grey.   

If a filter is set, the Filter button is red.   
 
 
 
 
 
Example: To find a project click on the Filter button. You 
will see the Filter Projects and Submissions window. 
Define the filter criteria of your choice and click Apply. To 
clear all filter criteria, use the Clear button. 

 

 

The Sort The Tree button sorts the project tree.  
 
Choose a sort criterion in the Unlinked Sort Criteria list 
and move it to the Linked Sort Criteria list using the 
transfer bar. Apply with the Sort button. 
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Explanation Example 

Enlarge or minimize panels by using the black arrows. 

            
To minimize the right panel, click on the black arrow point-
ing right. To see the hidden panel again click on the arrow 
pointing left. 
Customize the size of the panels by drag and drop using 
the left mouse button. 

 

  

Help button: 
Link to the MetIDQ™ YouTube video tutorials.  
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4 Processing the Kit 
The MetIDQ™ software supports you during the entire Kit workflow. The table below describes 
the MetIDQ™ elements used in order to prepare and to run a Kit. 

Element Short description 

MetLIMS 
Laboratory Information Management System. This module is the starting point for 
the assay. In the MetLIMS module you create a project, register samples, and 
generate the plate layout and worklist for mass spectrometer processing. 

OP 
OPs (Operating Procedures) are loaded by database patches (see section 7.7) into 
MetIDQ™ and contain specific processing instructions for the assay. You must link 
one OP to the worklist (Kit plate) you are working with (see page 45). 

Plate Report 
A plate report is generated together with the worklist. It provides a graphical view 
of the plate layout and the location of each sample on the Kit plate. This helps you 
to pipette all samples correctly. 

.csv/.txt file 
for MS data ac-
quisition 

Analyst®: MetLIMS generates a .csv file for each Kit plate. The .csv file must 
be loaded into Analyst® before starting the mass spectrometer run. 
MassLynx™: MetLIMS generates a .txt file for each Kit plate. The .txt file must 
be loaded into MassLynx™ before starting the mass spectrometer run. 
Xcalibur™: MetLIMS generates a .csv file for each Kit plate. The .csv file must 
be loaded into Xcalibur™ before starting the mass spectrometer run. 

 

Detailed instructions for all MetIDQ™ steps start on the next page. Please follow these in-
structions in the order they are presented. It takes approximately 30 minutes to create a pro-
ject, register the samples and generate the worklist in MetLIMS. 



Page 28 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

4.1 Registering the Assay in MetLIMS 

4.1.1 Registering a new Assay 
In this section you will create a new contact, project, and submission record for the assay. After 
this you can register and add samples to the assay. 

 
MetIDQ Project Start: Registration, Contacts and Users 

 
Step Instructions Example 

1 

Create a new contact in the Contacts tab in 
the MetLIMS module. Each contact consist 
at least of a Company Name and Contact 
Person. 

 

2 Click New in the toolbar. 
 

3 

The New Contact dialogue box will appear. 
 
It is up to you to keep the contact details sim-
ple or more detailed. Mandatory fields are la-
beled with an asterisk (*). 
 
Click OK when finished. 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

4 

You will see your contact record. Use the 
Edit and Delete buttons above the listing to 
edit or delete the selected contact record. 
By clicking the Link State button, you can 
see all linked projects the contacts. 

 

 

5 
Now you are ready to register a project. 
Choose the Projects tab. 
Click New Project in the toolbar.  

6 

You will see the New Project record win-
dow. 
Choose the contact from the Unlinked Con-
tact list. Move it to the Linked Contact list 
with the transfer bar. 

 

 

The transfer bars (add or remove) are used 
in all MetIDQ™ data transfer windows. To 
link e.g. a contact, select it by clicking on it. 
Then use the green arrow to link it. 

 
or 

 

7 

Click on the Project Members tab to restrict 
access to the new project for selected Met-
IDQ™ users. 
By clicking the transfer bar, you can add us-
ers to the Linked Project Members list. 
Note: If no members are linked, everybody 
will have access to the project.  



Page 30 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

Step Instructions Example 

8 
Give the project a unique code and name, 
e.g. Demo Metabolomics. 
A Description is optional.  

9 

You will see the project listed in the MetLIMS 
project tree. 
 
With the Filter button you can filter your pro-
jects and submissions.  

 

10 

Create a new submission for the project. A 
project may have one or several submis-
sions. Click on the project name in the pro-
ject tree, then click New Submission. 

 

 It is generally most convenient to use an individual submission for every prepared Kit. 

11 

Usually all samples analyzed by one Kit are 
part of one submission. 
You will see the New Submission registry 
window. Enter a name for the submission, 
e.g. Biocrates Kit.  

12 

You will see the project and the submission 
in the MetLIMS project tree. Now you can 
register your samples and add them to the 
submission (Kit plate). 
Continue with section 4.1.2 / 4.1.3. 
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Step Instructions Example 

 

Backup and data transfer: 
You can export and import projects or sub-
missions with the buttons shown on the right. 
To export data, select the project you want 
to export and click Export Project. If you 
want to export a submission, choose Export 
Submission by clicking on the black arrow. 
The Export data window will open and you 
have to name your export file. Files will be 
saved as MetIDQ™ Export files (.metidq). 
To import data, click Import Project / Im-
port Submission. Then choose the .metidq 
file in your directory you want to import to 
MetIDQ™. 

 
 

 
 

 

There is no difference in the file extension (.metidq) irrespective of the exported type, project 
or submission! A submission can only be imported as submission and a project only as project. 
.metidq files are database version dependent. 
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Step Instructions Example 

 

Import Worklist: 
 

In case you deleted an already measured 
project or submission by accident, you can 
regenerate the plate layout (MetIDQ™ work-
list) based on the MS raw files of the meas-
ured Kit plate. 
1. Select an existing Submission or create 

a new one 
2. Select Import Worklist 
3. In the dialog box select the folder con-

taining Kit MS RAW files (e.g. all MS files 
of an p180 Kit measurement) 

4. Select Open >>> A worklist is generated 

  

1. 
 

2. 

 

3. 

 

Example: MetIDQ™ can import MS raw date (see section 5 Quantitation) only if the corre-
sponding plate was registered. If a kit plate to corresponding MS data is not registered, e.g. if 
kit data was received from another user, use the Import Worklist feature to generate the work-
list in MetIDQ™. Then import the corresponding MS data via MetCONC. 
 
Note: When using the Import Worklist feature, samples that are not available in MetIDQ™ are 
registered. These newly registered samples, contain only this information: 
• sample bar code, well position, injection number 

 

Other information, e.g. “sample identification”, can be imported via MetLIMS > Sample Regis-
tration using the function “Import”, see 4.1.3.1 Import Sample Information. 
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MetIDQ Project Start: Sample Registration, Groups, Varia-
bles 

4.1.2 Define Groups and Variables (Optional) 
You can define further information about your samples in MetLIMS. For example, clinical infor-
mation like disease state or numerical information (e.g. patient age or treatment details) can be 
defined as categories, groups and variables in MetLIMS. Later, these elements will be displayed 
together with the assay results. Also, the MetIDQ™ StatPack module uses these categories and 
groups for statistical data analysis. 
In order to define groups or variables, follow the instructions in section 7.3. Define Groups and 
Variables in MetLIMS. When finished, return to section 4.1.3 Sample Registration in MetLIMS. 

4.1.3 Sample Registration in MetLIMS 
In this section you will register the samples for the Kit assay. MetIDQ™ can only calculate the 
metabolite concentrations of samples that are registered in MetLIMS. There are two ways to reg-
ister new samples: 
• If you have a small set of samples, you can register each sample individually. Follow the 

instructions in section 4.1.3.2 Register Single Samples. 

• The best way to import many samples is by a .txt or .csv file import. Follow the instructions 
in section 4.1.3.1 Import Sample Information. 

 

 

Pool or user’s QC sample: 
Register every sample only once. Every sample can be run in replicates on one kit plate and 
on different kit plates. 

Example: 
Replicates of a pooled plasma sample should be analyzed using several kit plates. Aliquots of 
the pooled plasma sample are available. Register this pooled plasma only once, as each ali-
quot consists of the sample. 

  

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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4.1.3.1 Import Sample Information 
By following the instructions below, you can import the sample information of all your samples in 
one step. During the import process you can also link pre-defined groups and variables to the 
samples. 

Step Instructions Example 

1 
Click on MetLIMS. Then click on the Sample Regis-
tration tab. 

 
 

 

2 

Find the example file 
MetIDQsample_import_Example (as .txt and .csv 
file) on the Kit USB stick and open it with Excel™ or 
a similar program. Use this as template for your sam-
ple information import file. You can import columns 
like sample identification and columns containing in-
formation on groups and variables. 
The worksheet of the template (screenshot on the 
right) contains the columns 
• sample identification 
• gender   containing the groups male and female 
• age 
 
Note: If using a Microsoft™ Excel™ worksheet, add 
a column test after the last column you want to im-
port. Put any entry in each row of the column test, 
e.g. 1. 
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Step Instructions Example 

3 

If you want to import information on groups, have the 
category’s name in the header, e.g. gedner. Type the 
exact name of each group into the column, e.g. male 
and female. 
Note: The fields are case sensitive so the group 
names must match exactly between the worksheet 
and MetIDQ™. 
 
Save the worksheet as a .txt or .csv file. 
Supported delimiter: semicolon “;”, tab and comma “,” 

 

4 

Each category and corresponding groups, as well as 
each kind of variable must be defined in MetIDQ™ 
before you import your sample information. 
See MetIDQ section 7.3 Define Groups and Varia-
bles in MetLIMS.  

 

5 Click Import to start the sample information import. 
 

6 Choose the .csv or .txt file you want to import. 

 

7 

Choose the delimiter used in your spread sheet (.txt 
or .csv) from the Import Settings drop down menu. 
You can use any delimiter listed: 
semicolon “;”, tab or comma “,”  
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Step Instructions Example 

8 
MetIDQ™ will open the file in the Sample Importer 
window. Available columns are listed in the field File 
Columns. 

 

9 

Link the data from your spread sheet with the avail-
able columns in MetIDQ™. To do this click on one 
entry in the Available Columns box and on the cor-
responding entry in the File Columns box. Then 
click on the yellow link  button located between 
the two boxes.  

10 Linked entries appear in the Links table. 
 

11 Click the Preview button.  

12 
This information box will appear when the data has 
been prepared for import. 
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Step Instructions Example 

13 
The Preview table shows you the layout of the in-
coming data. In this example, cohorts are separated 
into two gender columns. 

 

14 

Now you can add other sample specific information. 
Choose them in the Additional Required Infor-
mation box. In addition, you can link the samples to 
a pre-defined contact and submission. 

 
 
You can also choose the sample material from the 
drop-down menu. 
Note: Information such as material and species will 
be linked to all imported samples. In case you are 
analyzing samples of different material or species on 
one Kit plate, we recommend importing separate 
sample lists. 
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Step Instructions Example 

15 

 

Click Import. 
 
 
 
 
 
After the import, details are available by clicking on 
the arrows. Click OK to close the Import Summary 
window. 

 

 

 

Existing samples in the MetIDQ™ database can be 
updated by the procedure described in steps 1 - 15. 
Activate the option Update existing samples (blue 
frame). For this it is necessary to link a column con-
taining the MetIDQ™ Sample Bar Codes. In addition, 
link all columns containing information for the update 
process. 

 

16 
You will see the samples listed in the Samples table. 
The samples are now registered and can be used to 
create a worklist. 
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4.1.3.2 Register Single Samples 
If you have a small number of samples, you can register each sample individually. To do this, follow 
the instructions in this section. 

Step Instructions Example 

1 
Choose the Sample Registration tab. 
 
Click New Sample in the toolbar. 

 

 

2 

The sample registry window New Sample will ap-
pear. Enter information at least in each field with an 
asterisk (*). The table below gives information 
needed for each field. 
Note: For the fields Org. Info and Sample Identifi-
cation you cannot use the following special charac-
ters: / \ ? * : | “ < > 

 

 

 Field Instruction 

 Contact 
Select a contact, which was registered 
previously, from the drop-down menu. 

 Species Choose from the drop-down menu. 
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3 Choose a Material from the drop-down menu. 

 
 Field Instruction 

 Org. Info 
Enter further sample information. This 
field is optional. 

 Sample Identification 

Enter internal lab information for each 
sample. This can be any sample infor-
mation used to track the samples. 

 

Only this information will be shown 
in the plate report, worklist and as-
say results table. 

 Sample Description In this field you can add any information. 
 

Step Instructions Example 

4 
If you are using the Zebra TLP 2824 Plus barcode 
printer you can print barcodes. Define the number 
of printed barcodes. The default number is 0.  

5 
Click OK when finished. 
New sample are shown in the Samples list. 
To add more samples, click New Sample again. 
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Step Instructions Example 

6 
To search for samples, use the Filter – button in 
the upper right corner 

 

 

 
After registering all samples for the assay, create a project worklist and a plate report. 
See MetLIMS section 4.1.4 Generate Plate Layout and Worklist for MS run (page 45). 
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4.1.3.3 Import Samples containing “homebrew” concentration values 
Any concentration data that were not obtained by Kit measurements can be imported together with 
sample information and pre-defined groups and variables. 

Step Instructions Example 

1 Choose the Projects tab. 
 

2 

Register a new Project and Submission or a new 
Submission in an existing project, e.g. “User Con-
centration Data” (see 4.1.1 Registering a new As-
say). 

 

3 
Right-click on a submission (e.g. “User Concentra-
tion Data”) and select Import Data. 

 

4 

Select the file (*.csv or *.txt) containing sample and 
concentration information. Please find an example 
file “ExampleDataImport.csv” on the USB memory 
stick in the folder “MetIDQ and Oracle”. 
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Step Instructions Example 

5 

The same import dialog opens which is described in 
section 4.1.3.1 Import Sample Information. There 
are two columns: 

• Sample Columns (1): Link all columns con-
taining sample information. 

 
 

• Concentration Columns (2): Link all col-
umns containing the compound names (e.g. 
Alanine, Example) or compound bio IDs 
(e.g. 15570 from a database like ChEBI). 
Each compound name must be defined as 
header name in the .csv or .txt import file 
(see “ExampleDataImport.csv”). 

 
 

 

 All concentration values are automatically imported with the unit µM. 

6 

Select Preview and Import according to section 
4.1.3.1. Analytes which are not part of the MetIDQ™ 
database are listed in the Import Summary in the 
section “not importable concentration columns”. 
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Step Instructions Example 

 

When importing analytes which are not part of the 
database you will be asked to submit them to the BI-
OCRATES Support Team. We will generate a Met-
IDQ™ patch for you containing all needed analytes. 
You can directly request the patch by submitting this 
“error” to us or by copying the “error” message and 
sending it to support@biocrates.com.  

7 

User specific data are now loaded to a newly gener-
ated worklist (OP: DATA-0-1) which belongs to the 
selected submission. Every sample is linked to an in-
dividual well position. 

 

8 

To show and analyze the data, right click on the plate 
and select “Show Statistics Data”. All data from the 
selected Kit plate will be shown in MetSTAT > Dis-
play Data (see page 117).  

  

mailto:support@biocrates.com
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4.1.4 Generate Plate Layout and Worklist for MS run 

 
MetIDQ Project Start: Worklist Generation 

 

Step Instructions Example 

1 

Open a project in the Project Tree. Choose the sub-
mission (created in section 4.1.1). 
 

Click on the transfer bar (Add) and choose the sam-
ples you want to link to the submission. Use the filter 
button to find the samples of your choice. 
 

Select the samples you want to add and click Add or 
Add & Close. The samples are added to the sub-
mission. 
 

If you have linked the samples to a submission dur-
ing sample import (section 4.1.3.3), the samples will 
already appear in the Linked Samples window. 

 

 

 

To distinguish between samples that are already 
linked with a worklist and those that are not, use the 
filter option “Already in Worklist”.  

2 Click Generate Worklists.  

3 
You will see the Select OPs window first. 
Please refer to the lists below to select the appropri-
ate OP for your Kit and MS instrument.  

  

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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AbsoluteIDQ® p180 Kit 
 

Manufacturer SCIEX 

Instrument 4000 series 4500 series 5500 series 

LC variant HPLC HPLC UHPLC HPLC UHPLC 

LC OP KIT2-0-5404 KIT2-0-5404 KIT2-0-5414 KIT2-0-5504 KIT2-0-5514 

FIA OP KIT3-0-5404 KIT3-0-5404 KIT3-0-5404 KIT3-0-5504 KIT3-0-5504 

 

Manufacturer SCIEX SCIEX 

Instrument 6500 series 6500+ series 

LC variant HPLC UHPLC HPLC UHPLC 

LC OP KIT2-0-5604 KIT2-0-5614 KIT2-0-5704 KIT2-0-5714 

FIA OP KIT3-0-5604 KIT3-0-5604 KIT3-0-5714 KIT3-0-5714 

 

Manufacturer Waters Xevo  Thermo Fisher 

Instrument TQ-S TQ-S micro TQ-XS  TSQ Vantage™ 

LC variant UPLC UPLC UPLC  HPLC UHPLC 

LC OP KIT2-0-8115 KIT2-0-8215 KIT2-0-8315  KIT2-0-9004 KIT2-0-9014 

FIA OP KIT3-0-8115 KIT3-0-8215 KIT3-0-8315  KIT3-0-9004 KIT3-0-9004 
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AbsoluteIDQ® p180 Kit 
 

Manufacturer Agilent 

Instrument 6470 

LC variant UHPLC 

LC OP KIT2-0-7111 

FIA OP KIT3-0-7101 
 

 

 
 

AbsoluteIDQ® p150 Kit 
 

Manufacturer SCIEX Waters Xevo Thermo 
Fisher 

Instrument 4000 series 5500 series TQ MS TQ-S TSQ Vantage™ 

LC variant FIA FIA FIA FIA FIA 

OP KIT1-0-5 KIT1-0-5505 KIT1-0-8006 KIT1-0-8106 KIT1-0-9005 
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MxP® Quant 500 Kit 
 

Manufacturer SCIEX SCIEX 

Instrument 5500 series 6500 series 

LC variant UHPLC HPLC UHPLC HPLC 

LC OP MxP500L-0-5511 MxP500L-0-5501 MxP500L-0-5611 MxP500L-0-5601 

FIA OP MxP500F-0-5501 MxP500F-0-5501 MxP500F-0-5601 MxP500F-0-5601 

 SCIEX  Waters 
 6500+ series  Xevo® TQ-S 
 UHPLC HPLC  UHPLC 

 MxP500L-0-5711 MxP500L-0-5701  MxP500L-0-8111 

 MxP500F-0-5701 MxP500F-0-5701  MxP500F-0-8101 
 

 

 
 

AbsoluteIDQ® Stero17 Kit 
 

Manufacturer SCIEX  Waters Xevo 

Instrument 5500 series  TQ-S TQ-S micro 

LC variant HPLC UHPLC  UPLC UPLC 

OP ST17-0-5502 ST17-0-5512  ST17-0-8112 ST17-0-8212 
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AbsoluteIDQ® p400 HR Kit 
 

Manufacturer Thermo Fisher 

Instrument Q Exactive™ 
Focus Q Exactive™ Q Exactive™ 

Plus 
Q Exactive™ 

HF 

LC variant UHPLC UHPLC UHPLC UHPLC 

LC OPs 
KIT2-0-1011 KIT2-0-1111 KIT2-0-1211 KIT2-0-1311 

KIT2-0-1012 KIT2-0-1112 KIT2-0-1212 KIT2-0-1312 

FIA OPs 
KIT3-0-1011 KIT3-0-1111 KIT3-0-1211 KIT3-0-1311 

KIT3-0-1012 KIT3-0-1112 KIT3-0-1212 KIT3-0-1312 
 

 

 

Biocrates® Bile Acids Kit 
 

Manufacturer SCIEX 

Instrument 4000 series 5500 series 6500 series 

LC variant HPLC HPLC UHPLC UHPLC 

OP BA02-0-5402 BA02-0-5502 BA02-0-5512 BA02-0-5612 
 

Manufacturer Waters Xevo  Thermo Fisher 

Instrument TQ-S TQ-S micro  TSQ Vantage™ 

LC variant UPLC UPLC  UHPLC 

OP BA02-0-8112 BA02-0-8212  BA02-0-9012 
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The use of the filter in Select OPs is ex-
plained by the exemplary OP 
KIT2-0-5404: 
 

 KIT2    –      0      –       5404 
 OP Code – Material – Version Number 

 

 

p180, p400 HR, and MxP® 500 Kits: 

LC plate: Register the plate layout with zero, blank, calibration standards, QCs, and samples, 
using the appropriate KIT2 OP (KIT2-0-xxxx) or MxP500L OP (MxP500L-0-xxxx). 

FIA plate: Duplicate LC plate, delete all calibration standards and alter the OP, see page 59. 

 



4. Processing the Kit Page 51 

 

 

Step Instructions Example 

4 
Transfer the selected OP to the Linked OPs list with 
the transfer bar, e.g. KIT2-0-5404. 

 

5 Click Next.  

6 
You will see the second worklist wizard. Here, you 
can configure the plate layout. 

 

7 The table overleaf explains the three options. 
 

 Choice Explanation 

 Horizontal The plate will be pipetted horizontally. 

 Vertical 
The plate will be pipetted vertically, de-
fault setting. 

 Machine-made (optional) Use with Hamilton® Robotics system. 

8 
If you want to randomize the sample sequence click 
Randomize Samples. Blank, zero sample, standard 
and QC well positions will not be randomized.  
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Step Instructions Example 

9 

Look at the first two tabs. The number in brackets 
corresponds to the number of samples that are 
linked to the Kit plate. See the table below for more 
information on the tabs. 

 

 

 Tab Choice Explanation 

  
This is pre-configured 
and cannot be changed. 

Well A1 on the Kit plate does not have 
internal standards. It is called Blank. 
This blank well is used to determine 
the background counts and to check 
your system for contaminations. 

  

For plasma samples, 
PBS is recommended as 
zero sample (linked by 
default). 

Internal standards but no analytes 
added. Used to calculate the limit of 
detection (LOD) for each analyte. 
Three replicates are recommended for 
the p150, p180, and p400 HR, and 
MxP® 500 Kit. 
 

Bile Acids and Stero17 Kit: 
Change replicates from 3 to 1. 

 

Step Instructions Example 

10 
Calibration standards and QCs are already regis-
tered in MetLIMS.  

11 Click on the Standards tab.  

 
Standards are used for LC-MS/MS analytics only. No Standards will be linked in a FIA-MS/MS 
assay. 
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Step Instructions Example 

12 

Select the set of calibration standards of your Kit in 
the Unlinked Standards list and then use the trans-
fer bar to move the standards to the Linked Stand-
ards list. 
 

Make sure that the sample barcodes of the selected 
standards match the barcodes on the standard vials 
included in the Kit! 

 

13 Click on the QC lots tab.  

14 

Look at the QC Pools list and select the QC Pool 
displayed on the QC vials included in the Kit. 
 

You will see the QC lots in the Unlinked QC-Lots 
listing (as shown in the example on the right). Use 
the transfer bar to move all three QC lots to the 
Linked QC-Lots list. 
 

Make sure that the sample barcodes of the selected 
QCs match the barcodes on the QC vials! 

 
 

 

15 

Now QCs are linked to the submission. 

 
Recommendation: run a QC2 replicate after every 
20th sample. Define the number of replicates accord-
ingly. Activate the checkbox “Distribute Replicates”, 
resulting in a equal distribution over the plate (see 
also 7.1 Data Normalization). The last sample on the 
plate is a QC replicate. 
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Step Instructions Example 

 

Example: Distribute QC replicates equally over a Kit plate 
By activating the function “Distribute Replicates” the specified QC level (here QC2) is distrib-
uted equally over all linked samples on one Kit plate. If you would like to distribute 4 QC rep-
licates over one Kit plate, please calculate the number of available positions for your samples 
on the Kit plate (79 on the plate below). When linking more than 79 samples, MetIDQ™ will 
generate an additionally Kit plate automatically. 
 

Please keep in mind: 
• The number of QC replicates does not automatically increase when more than one Kit 

plate is generated. 
• The last well position is always a QC replicate, if “Distribute Replicates” is activated. 
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Step Instructions Example 

16 

To finish the plate layout, choose the Samples tab. 
The number in brackets corresponds to the number 
of samples that are linked to the Kit plate. Here it is 
26. 

 

17 

All samples linked with a submission are shown. Fur-
ther samples can be added. Injection replicates per 
sample can be defined. 
 
Choose the sample from the Linked Samples list. 
Double click on the Replicates column. Use the 
counter to change the number of replicates. Click 
outside of the field to save your changes. Here, three 
replicates of one sample are chosen. 
 
In order to change the number of replicates for more 
than one sample, select the samples by holding the 
Shift button pressed (press Ctrl + A to select all), right 
mouse click in the header of the corresponding col-
umn and enter the value 

 

   

 

The Sample Volume corresponds to the volume you 
pipette onto the Kit plate. This is pre-defined by the 
selected OP and normally 10 μL. Based on this vol-
ume, the final metabolite concentrations will be cal-
culated by MetIDQ™. Before you change the pre-de-
fined value, please contact our Customer Support. 

   

18 
If you want to see the plate layout before you gener-
ate the final worklist, click on the Positioning tab at 
the bottom of the window.  
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Step Instructions Example 

19 

The plate layout will be displayed based on your 
specifications. Specific colors are used for each 
sample type. 
 
 
 
 
An example plate layout as overall positioning list is 
shown on the right. 
 
You can move samples from one well to another us-
ing the standard drag-and-drop technique. The tab 
below illustrates this procedure. 

 

 

 

To move a sample on the plate: 
1. Move the mouse pointer to the sample well you 

want to move. 
2. Hold down the left mouse button. 
3. Drag the sample to a new position on the plate. 

You will see the mouse pointer over the shape. 
4. Click Yes to make the change. 

  

 

20 
When you are satisfied with the plate layout, click 
Generate Worklist.  
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Step Instructions Example 

21 

When the worklist generation is finished, the window 
shows two panels. The upper panel shows the Plate 
Runs. In the panel below you can choose between 
the Well List tab and the Plate View tab, which 
shows the plate layout. 
 

Each plate has a plate production number attached 
(for example, P08265). Enter this number in the 
Plate Production No. field.  

 
You can also enter a note. Double click onto the 
Note symbol, type in your note and click OK.  

 

The plate layout can be changed, e.g. do copy-past 
of a well in the Plate View. 
To move or copy a sample on the plate: 
1. Select a well with right mouse click. 
2. Choose Copy or Cut. 
3. Move the mouse to an empty well on the plate. 
4. Right click and choose Paste. 
5. The sample will be moved to the new position. 

  

22 

Usage of the Tissue Factor Tool: 

If you are measuring tissue samples, type in your 
μL/mg Tissue Factor into the Well List. To update 
multiple samples, select the tissue samples while 
holding the Shift button (press Ctrl + A to select all), 
right-click in the header of the Tissue Factor column 
and enter the μL/mg factor that you used for tissue 
homogenization. 

 

 For further information see section 7.10 Usage of the Tissue Factor Tool. 



Page 58 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

Step Instructions Example 

23 

Usage of the Cell Normalization Tool: 

If you are measuring cell extracts, type in your num-
ber of cells and the volume of extraction solvent [µL] 
in the Well List. 
To enter the same number of cells or amount of ex-
traction volume for more than one sample at the 
same time, select the samples while holding the Shift 
button (press Ctrl + A to select all), right mouse click 
in the header of the corresponding column and enter 
the value. 

 

For further information see section 7.11 Usage of the Cell Normalization Tool. 

24 
MxP® 500, p180 and p400 HR Kits: now the worklist 
for the LC part was created. Copy the worklist to ob-
tain the FIA worklist as described in the next step. 
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Step Instructions Example 

25 

MxP® 500, p180, and p400 HR Kits only – How to copy a plate 

Use the worklist for the LC part as template. 
 

To generate the FIA worklist, right click anywhere on 
the LC worklist and choose copy. 

 

Right click somewhere below the LC plate and select 
Paste derived plate. 

 
- A copy of the LC worklist was created. 
- Use this copy to create the FIA worklist. 
- Change the OP: double click into the field OP 

and select the appropriate OP of the FIA part. 
 Refer to section 4.1.4, page 45  

FIA part: calibration standards are not used and can 
be deleted from the FIA plate layout. Select all cali-
bration standards, right click and choose Delete. 

 

 
If you want to delete a single worklist, select the respective plate, do right click, and choose 
Delete. Choosing Delete Worklist will remove all plates of the currently selected worklist. 
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Step Instructions Example 

26 
When everything is completed, change the "Condi-
tion" from Pending to Approved. 

 

 
After the condition has been set to Approved, modifications in the Plate View tab are no longer 
possible. To revise the plates, set the condition back to Pending. 

 

If you want to analyze a large number of samples, watch the following video (in addition to the 
video MetIDQ™ Project Start: Sample Registration, Groups, Variables). 

    
MetLIMS and Complex Projects, Bar Code Printing, 
Search, Filter, Import and Export 

  

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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4.1.5 Export Worklist for Kit measurement 

 
MetIDQ Project Start: Worklist Generation 

 
 

Step Instructions Example 

1 
To export a worklist for Kit measurements, the Met-
IDQ™ worklist(s) "Condition" must be set to Ap-
proved. 

 

 

2 
Choose Export Worklist for MS, from the toolbar 
above the Project Tree. 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

3 
You will see the Export Options dialogue box. 
Choose a folder for the Worklist Export. A detailed 
description is provided below. 
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 Item Definition 

 
 

Selected style of .csv sequence file name for Analyst® is 
shown, e.g. “default”. 

 

The style may be defined in the settings: 

  
 
  

 
 

Choose your MS type and autosampler in the drop-down 
menus. 

  

Leave the run number as 1, except when you want to per-
form another run of the same Kit plate. In this case, increase 
the run number accordingly, as this will ensure that different 
MS raw files (e.g. .wiff, .raw) are created. 

 

 

Order by Sample is the default setting and recommended. 

 
 

Select the plates you want to export/measure and select the 
rack position in the autosampler . 
 

For Thermo autosampler1: 
Rack positions G, R, B and Y are available 

 
 

  

Samples will be injected randomly when activating this 
checkbox. Blank, zero, calibration standards, and QC sam-
ples will maintain their positions. 

 
To print plate barcodes and/or sample barcodes you must activate the corresponding check 
boxes. 
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For SCIEX® users – p180, Bile Acids, Stero17 Kits only: 
With MetIDQ™, it is possible to perform the quantitation in the Quantitation Wizard of the 
Analyst® software without copying the calibration standard concentrations from an Excel™ file. 
This feature can be activated in the MetIDQ™ MetLIMS settings (see screenshot below, “Sup-
port Quantitation in Analyst®”). If you use this feature, make sure you have copied your Kit 
quantitation method from the USB stick into the “Quantitation Methods” folder of your Analyst® 
project (MS operating computer). Do not rename the quantitation method! This quantitation 
method will be automatically selected in the “Quantitation” field in the Analyst® Acquisition 
Batch window when you import the csv file. During the quantitation procedure, steps 7 and 8 
can be skipped, see page 32 in the manual “UM_p180_SCIEX_##.pdf”. 

 Quant 500 Kit: do not activate this option! 

Alternatively, you can find the Excel™ file with the concentrations of the calibration standards 
on the USB memory stick (“Calibrator_Conc_KIT2_5xx4”). If you deactivate the checkbox be-
low, you must copy the concentrations according to the manual “UM_p180_SCIEX_##.pdf” 
(see step 7 and 8 on page 32). 

 
 

 

 

For Thermo users: 
The path where the Xcalibur™ acquisition methods are located on the MS operating computer, 
e.g. KIT2-LC_9014.meth, can be included in the worklist file (.txt). For this define the path, e.g. 
c:\xcalibur\method, in the Settings > MetLIMS as shown below. 

 
 

 

 
1 The position and color code correlation may not apply to all Thermo Dionex autosampler and MS instrument combinations. 
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4 MetIDQ™ will generate the folder “MetIDQ Worklist Export” with the following files. 
 

 Subfolder Definition 

 barcodes Contains the barcode label of each plate. 

 
csv  (SCIEX) 
 
txt  (Waters, Thermo) 

Contains the acquisition batch and must be imported into 
the MS software (MassLynx™, Analyst®, Xcalibur™) 

 plate report 
Contains the plate report and can be referenced during pi-
petting of the kit plate. 

 worklist Contains the sample list. 

 Plate report Worklist 

 

  

 xml Used by MetIDQ™ to generate a plate report and worklist. 
 

 
Please refer to the Kit user manual for processing the Kit. 
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Video Tutorials – Processing the Kit 
In addition to the Kit user manuals, video tutorials are available. They describe the steps in the MS 
software and how the data is quantified. Depending on the MS instrument, watch the correspond-
ing video tutorial: Waters, SCIEX or Thermo. 
 

 

SCIEX – Analyst® 
- MS Measurement: Batch File/Acquisition Method Import for AB Sciex MS Instruments 

- AB Sciex MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 
 

Waters – MassLynx™/TargetLynx™ 
- MS Measurement: Batch File/Acquisition Method Import for Waters MS Instruments 

- Waters MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 
 

Thermo Scientific™ – Xcalibur™ 
- MS Measurement: Batch File/Acquisition Method Import for Thermo MS Instruments 

- Thermo MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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5 Quantitation 
 

• Quantitation of LC and FIA data is performed using the MetIDQ™ software. The procedure is 
described in the following sections. 

• Optionally, LC data quantitation can be performed using the MS manufacturer’s software (Mass-
Lynx™, Analyst®, Xcalibur™), which is described in the kit user manual. 

• Results from LC and FIA part are validated, displayed, and visualized in MetVAL and MetSTAT. 
 
 

 

NEW Quant 500 Kit: LC data quantitation can be performed by MetIDQ™ (recommended) or 
the MS software (Analyst®, MassLynx™). For best longitudinal data comparability, we recom-
mend continuing using the MS software for LC data quantitation, if the p180 Kit was used before. 

 
 

Important: To generate reproducible and longitudinal comparable data, do not change the 
acquisition method, quantitation method, or software version within one study. 
For LC data quantitation use either MetIDQ™ or the MS software (Analyst®, 
MassLynx™, Xcalibur™). 
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5.1 LC data quantitation – MxP® Quant 500 Kit 
 

 

This feature is only available for MxP® Quant 500 Kit data. 
LC data quantification of other Biocrates® Kits uses the corresponding MS software (Analyst®, 
Xcalibur™, or MassLynx™). 

 

Step Instructions Example 

 
For LC-MS data quantitation use, “.” as decimal separator. 
Recommended: set number format in Windows™ control panel to “English (UK)“ or “English (US). 

1 Go to the MetCONC module. 
 

2 
Import LC-MS data (.wiff or .raw): 
Select the “Import Raw Files” tab.  

3 

Click “Add Files” and Select the correct file type: 

Analyst®  Analyst® raw files (.wiff) 

MassLynx™  Waters raw file [dir] (.raw) 

Xcalibur™  Thermo raw files (.raw) 

Choose all LC data from one kit run. 
 

 

 

 Load LC data files from LC1 and LC2 injec-
tions. 

 

- To load all files of one folder, press Ctrl + A 
- To load selected files, keep the Ctrl or Shift key 

pressed while clicking. 
Click Open. 
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Step Instructions Example 

4 

Click Yes. 

 
 

Storing MS data in database: 
For a later re-integration or adjustment of in-
tegration parameter, it is recommended to 
store MS data in the database. 

5 
After MS data is imported, a list of imported samples 
is shown in the “Job Table”. 

 

6 
Select the line with the plate barcode, here it’s 
1020341129-1. 

 

 Import Retention Times (RTs) – optional 

7 

Import retention times (RTs): 
 

1. Click Adjust RTs 
2. Click Import 
3. Select a .csv file containing RT ranges. 

 

Information: MetIDQ™ OPs are provided without RT 
windows. Default RT windows (integration ranges) 
can be imported from a .csv file, e.g. from USB stick: 
folder “SCIEX\Acquisition and Quantification Meth-
ods\_Documents”. 

 

 

 
 
 
Example RT ranges on USB Stick: 
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Step Instructions Example 

 

A .csv file containing integration ranges can be im-
ported, e.g. with RT ranges that were previously ex-
ported from MetIDQ™. 
Example: “MxP500 LC_RT_2018-10-24.csv”. 
To check the imported integration ranges or to set 
the ranges from scratch, continue with step 8. 

 

 Adjust Retention Times (RTs) and peak integration 

8 

Before starting with the RT adjustment procedure, you may modify the Quantification Config-
uration. They are available from the MetIDQ™ Settings. 

  
 
  

These options are available (see next page). 

 
RTs are specific for an LC-MS instrument. If several instruments are in use, specific Instrument 
Setting can be defined for each LC-MS instrument, e.g. “SCIEX 5500”. 
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 Option Definition 

 

 

Automated peak detection and integration 
is performed for each peak within a de-
fined range. This range can be defined, 
e.g. 10 % of RT window. 

  

RT borders within 10% inside RT windows: 

 

RT borders within 10% outside RT windows: 

 

 
 

Show or hide Blank and Zero samples in 
MetCONC Results. 

 

Instrument Configuration 

If multiple LC-MS platforms are used: 

Click  to create a new Instrument 
Setting. Later RTs can be saved specifi-
cally for each defined Instrument Setting, 
e.g. SCIEX 5500. 
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Step Instructions Example 

9 Click Adjust RTs. 
 

 
In the “Retention Time Settings” window, peak integration settings are defined. To check the 
integration settings, use QC level 2. 

10 

For RT adjustment, use QC level 2. 
 

 To adjust RTs of analytes analyzed with the LC1 method, 
select “Quant 500_QC2 [## Y (+)]. 

 To adjust RTs of analytes analyzed with the LC2 method, 
select “Quant 500_QC2 [## Y (-)]. 

 

e.g. Quant 500_QC2 [42 1 (+)] and Quant 500_QC2 [42 1 (-)] 
 

 

 

Two acquisition methods are used in LC part. Adjust the RTs of both injections. 
They can be identified by its name. 

LC1 run: Quant 500_QC2 [## Y (+)] 
LC2 run: Quant 500_QC2 [## Y (-)] 

##: well position, e.g. 42 
Y: injection number, e.g. 1 
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Step Instructions Example 

 

Only RTs of metabolites that were acquired with the 
selected LC data file are shown, e.g. 3-Met-His and 
5-AVA with the Quant 500 LC1 run (positive mode). 
The RT of 3Me-2OBu is not shown, since the data 
selected was acquired with another acquisition 
method (negative mode). To adjust all RTs, a repre-
sentative data file from both LC runs must be used. 

 

Analytes are highlighted in white, 
e.g. Betaine and CA. 
Internal standards (ISTDs) are highlighted in green, 
e.g. 13C2-Taurine-PTC and 13C3-LacAcid. 

Metabolites ISTDs 

  

11 

To adjust the RTs 
• sort the Retention Times by ascending order 
• select the 1st metabolite showing an RT, 

e.g. Betaine of the LC2 run (negative mode).  

 
The corresponding chromatogram is shown, 
e.g. of Betaine. 
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Step Instructions Example 

 

 

Zoom in Zoom out 

  
 
 

12 

Define the RT range – use the mouse pointer. 
1. Left click on the left side of the peak. 
2. Left click on the right side of the peak. 

 

 

Redefine the RT range: 
- Left click close to the green vertical line. 

Move the RT range: 
- Use the left and right arrow keys. 

 

To identify the correct peak, refer to the sec-
tion “Peak Identification” of the correspond-
ing kit user manual. 
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Step Instructions Example 

13 Define an Integration Type. These options are available. 

 Option Definition 

  

To save RT and integration settings for a spe-
cific LC-MS instrument, select an Instrument 
Configuration, e.g. SCIEX 5500. 

 
 

This feature is only available, if an In-
strument Configuration in addition to 
“Default” was defined. See page 71. 

  

Automated peak integration. 
Integration base line from peak beginning to 
end. 

 

  
Automated peak integration. 
Horizontal integration base line used. 

 

  

Manual peak integration. 
User defined peak integration window and 
base line. 

 

14  Repeat steps 12 and 13 with all metabolites. 
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Step Instructions Example 

15 Save the adjusted RTs. These options are available. 

 Option Definition 

  Discard all manual integration settings of the current sample. 

  
Use defined RT and peak integration settings for all new integration procedures, 
for the currently selected Instrument Setting, see page 71. 

  Apply defined RT and peak integration settings to current plate. 

  Close window and apply defined RT and peak integration settings to current plate. 

16 
Export the adjusted RTs and 
close the window Retention Time Settings.  

 Process LC Data 

17 
Select the line with the barcode of an LC plate, 
e.g. 1020341129-1. 

 

18 To begin with the quantification procedure, click Start. 
 
  

 

The peak integration and quantification process is 
completed when all samples status turned green. Af-
ter this process two windows open: 
 MetCONC Results and Calibration Curves  
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Step Instructions Example 

 Integration check 

 
To adjust peak integration settings in MetCONC Re-
sults, keep the Calibration Curves window closed. 

 

19 

Check the peak integration in MetCONC Results. 
 
Here, the retention times (RTs) 
- of all metabolites 
- of all samples 

are shown normalize to a scale from 0 to 1. 
 
 
Upper pane: 
- RT ranges of all metabolites are shown. 

 

Lower pane: 
- RTs of a selected metabolite in all samples are 

shown. 
 
 
A summary of all features is given below. 
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 Choice Explanation 

 
Select a metabolite: in the upper pane, click on a me-
tabolite name or click into the graph. 

Upper pane: 

 

 
Select a sample: in the lower pane, click on a sample 
or click into the graph. 

Lower pane: 

 

 The corresponding chromatogram is shown. 
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The lower pane shows the RTs and integration range 
of the selected metabolite. 

 

 
Check integration! 
Metabolites are highlighted in red, if their RT is out-
side or at the edge of the integration range. 

 

 

Adjust integration range: 
1. Select a metabolite and sample. 
2. Adjust the integration range. 
3. Click Reintegrate or the Enter key. 

 

 

  To apply an adjusted integration range, click  or press Enter for each peak. 
 

20 
Once the procedure has been completed, close the 
window “MetCONC Results”.  

 

To re-open the window “MetCONC Results”, go to 
MetVAL > Validation and click Check Integration. 

 

 

For this feature, set the Validation Settings to MANUALLY. 
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 Check Calibration 

21 

To check the calibration. Go to the window Calibra-
tion Curves. 
Here, all seven-point calibrated metabolites are 
shown in three separate tabs: amino acids, biogenic 
amines, and amino acids related. Check the perfor-
mance of all metabolites in all calibration levels. If re-
quired, adjust the calibration parameters. A summary 
of all features is given below. 

 
 

 Choice Explanation 

 Select the metabolite class. 
 

 Select a metabolite from the drop-down menu. 

 

 

You can change the “Curve Type” and “Weighting 
Type”. 
Default values: Curve Type Quadratic 
 Weighting Type 1/X  

 
Accuracies are shown in the table “Calibration 
Standards”.  

 
Accuracies outside the acceptance range are high-
lighted in yellow. 
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Exclude calibration level(s) for all metabolites of cur-
rently selected metabolite class. 

 

 

 Deselect in table “Calibration Standards” 
 

Information: excluded calibration level(s) are shown 
in red in the calibration curve window. 

 
Exclude calibration level for selected metabolite. 

 
 Click on corresponding calibration point and 

select “Remove”. 

 

Exclude calibration level for all metabolites of cur-
rently selected metabolite class. 

 
 Click on corresponding calibration point and 

select “Remove All”. 

  QC accuracies are shown in the table “QCs”. 
 

 

22 Once the procedure has been completed, click OK.  
  



Page 82 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

5.2 LC data quantitation – Import Result Files – all kits 
LC data quantitation can be performed using the MS software (MassLynx™, Analyst®, Xcalibur™), 
which is described in the corresponding kit user manual. The import of results is described below. 
 

 

SCIEX – Analyst® 
Sciex MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 
 

Waters – MassLynx™/TargetLynx™ 
Waters MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 
 

Thermo Scientific™ – Xcalibur™ 
Thermo MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 
 

 

 

This feature is available for all Biocrates® kits. 
If used for the MxP® Quant 500 Kit, the integration and quantitation procedure described in 
section 5.1 must be performed in addition. 

 

Step Instructions Example 

 

For LC-MS data quantitation use “.” as decimal separator. 
Recommendation: set number format in Windows™ control panel to “English (UK)“ or “English 
(US). 

 

Results from the Analyst® software can be imported from a text-based result file (.txt). 
The import of Analyst® result files (.rdb) is no longer supported. 

 
For a description how to generate text-based result file, refer to section 7.13. 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

1 Click on the MetCONC symbol. 
 

2 
Import LC-MS results (.txt or .xls): 
go to “Import Result Files”.  

3 

Click Browse and select the result file according to 
your instrument manufacturer: 
 
Analyst®  “sciex result files (*.txt)“ 
MassLynx™  “waters result files (*.txt) 
Xcalibur™  “thermo result files (*.xls) 

 

4 

Click No. 

 
 

Storing MS data in database: 
Not required when during LC results import. 

5 
After the import process, validate the plate, 
see section 5.4. 
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5.3 FIA data – quantitation by MetIDQ™ 
FIA data is available using the MxP® Quant 500, p180, p400 HR, and p150 Kits. 

Step Instructions Example 

 
To import the FIA-MS data into MetIDQ™, it is recommended to set the decimal separator in 
the control panel of your operating system to “.” (dot). 

1 Go to MetCONC. 
 

2 
Import FIA-MS data (.wiff or .raw): 
go to “Import Raw Files”.  

3 

Click “Add Files” and select the correct file type: 
 

Analyst®  Analyst® raw files (.wiff) 

MassLynx™  Waters raw file [dir] (.raw) 

Xcalibur™  Thermo raw files (.raw) 
 

Choose all FIA data from one kit run. 

- To load all files of one folder, press Ctrl + A 
- To load selected files, keep the Ctrl or Shift key 

pressed while clicking. 

Click Open. 

 

 

4 

Store raw data files: recommended for LC data. 

 
 Storing MS data in database: 

Not required for FIA data. 
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Step Instructions Example 

5 

Define FIA profile width – required for these kits: 
 Quant 500 Kit 
 p400 HR Kit 
 p180 Kit Agilent edition 

Open example FIA MS files (.wiff or .raw) with the MS software, e.g. QC level 2 and an exam-
ple sample. Identify the start and end point of the FIA profile as shown below. 
In this example: - start point 0.6 min 

- end point 1.5 min 
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Step Instructions Example 

For a robust peak integration, subtract 0.2 min form 
the start point and add 0.2 min to the end point. 

- FIA Profile From [min] = 0.4 
- FIA Profile To [min] = 1.7 

Use these values for every FIA integration process. 
 

 

If no times are defined (Value = 0.00) the FIA profile is automatically identified. Defining 
the FIA profile width makes the FIA integration process more robust by excluding small 
signals outside the FIA peak. 

6 Imported files are shown in the Job-Table. 

 

7 To begin the quantitation procedure click Start. 
 

 The quantitation process is performed by MetIDQ™. 

 

8 
After the quantitation process, validate the plate, see 
section 5.4. 
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5.4 Validate the Kit Plate 
The MetVAL module performs an automated quality assessment of the Kit data and checks the 
performance of blank, calibration standard, QC samples, and internal standards (ISTD). Status 
and condition of a plate is shown well by well. 

 
MetIDQ: Validation Features in Detail 

 

Step Instructions Example 

1 
After each quantitation procedure, MetVAL module 
opens automatically. 

 

 
In MetVAL the plate/s loaded last is/are shown. To 
show additional plates, change the filter settings . 

 

 
The LOD for all metabolites is listed in the Analytical Specifications and is part of the MetIDQ™ 
database. Kit plate specific LODs can be calculated. 

2 

 Only for Quant 500 Kit data: 

 
 

 

Calibration: 
If not done previously, check and perform the cali-
bration according to page 80. 

3 
The validation process starts automatically. 

If the validation does not start or to re-validate a 
plate, click Validate. 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

4 
Calculate the limit of detection (LOD): 
To calculate the LOD, use the Optional Validation 
box. A summary of features is given below. 

 
 

 Choice Result 

 

Recommendation for at least 3 Zero replicates per 
plate: 
 

 

The median value of all zero samples 
on a plate is calculated as approxima-
tion of the background noise. 3 x this 
value is the LOD for each analyte, 
which is shown in the MetSTAT results 
table. 
 

 LOD = 3 x median background noise 
 

 

LC data: If no concentration value for a metabolite is available in a LC result file, 
the LOD defined in the MetIDQ™ OP is used. If a calculated LOD or an LOD from the 
OP is used, this is indicated in MetSTAT as shown below. 

 
 

Why might a concentration value not be available for a metabolite of a zero sample? 
The quantitation method may not detect peaks in zero samples in all analyte MRMs, 
due to low peak or signal intensities. 

 

Recommendation for less than 3 zero replicates per 
plate: 
 

 

The LOD values shown in the Analyti-
cal Specifications are used. These val-
ues are listed in the results table in 
MetSTAT. 
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Step Instructions Example 

 

The validated Kit plate, e.g. plate barcode 263099, is 
highlighted in the Project Tree. Change the filter op-
tions to choose another Kit plate. 

 

5 

The Plate Desk provides a detailed list of all plate 
information. 
 

Add notes to a plate: 
Double-click on the “Note” symbol. Notes are in-
cluded in QC-Reports.  
 

Re-calibrate a plate: 
Click the Calibrate button. 
 

Show peak integrations: 
Click the Check Integration button. 

 Available if validation was not approved. 
 

Generate a QC Report: 
Click the QC-Report button. A PDF is created. 
 

Go to MetSTAT: 
Click on the Plate Run number. 
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Step Instructions Example 

6 

The plate graphic shows the contents and status of 
each well on the plate. The wells are color-coded to 
show the sample type and status. 
Here, the sample has the status Valid, indicated by 
a green background (all values are within the range 
set by the OP). 
If a well is highlighted in yellow this indicates that one 
or more values are out of range. The reason should 
be evaluated. Use the mouse and scroll over any 
well to open box with more information on the sam-
ple. 

 

7 

Left click on a well to see the corresponding table 
with analytical details and the corresponding graph. 

 
 
* Concentrations isotope corrected 
(FIA part only) 

Use the right-mouse button to open LC-MS/MS or 
FIA-MS data files (LC data are only available if they 
were imported in MetCONC, see section 5 Quantita-
tion).  
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Step Instructions Example 

Different graphs are available in MetVAL to show the 
results for different sample types. Each of these 
graphs are explained and illustrated on the next 
pages. 
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5.5 Explanation of MetVAL Graphs 
MetVAL categories: Validation, QC Monitoring, and Analyte Overview. 

 
Validation page 93 

QC Monitoring page 106 

Analyte Overview page 112 

5.5.1 Presentation Options for all MetVAL Graphs 
Presentation Option Instructions 

See the graph on full screen 
Double-click on the graph to enter full-screen mode. Press Esc 
to return to normal size. 

Save the graph as an image file 
Right-click on the graph to show the context menu and choose 
“Save as” option. You can save the graphic as an image file for 
export. 

Print the graph 
Right-click on the graph to show the context menu and choose 
“Print” option. Choose the paper size and format as well as a 
printer. 

Zoom in/Zoom out 
Hold the left mouse button and drag it downwards to zoom in on 
the y-axis. Hold down the left mouse button and drag it upwards 
to zoom out. 

  



5. Quantitation Page 93 

 

5.5.2 MetVAL – Validation Graphs 

 
ISTD Graph (blank well) page 93 

ISTD Graph (other wells) page 94 

Standards Graph page 95 

QC Concentration Graph page 96 

Analyte Concentration Graph page 99 

5.5.2.1 ISTD Graph (Blank Well) 

The ISTD graph for the blank well is different from the ISTD graph for the other wells. 

Explanation Example 

The blank well is always on plate position 
A1. The graph shows the measured in-
tensities (cps) of the internal standards 
(ISTD). The maximum cps are shown as 
red dashes. The blank does not contain 
any ISTD, consequently the cps values 
should be below the max. cps limits. 
 

If an ISTD value exceeds the max. cps: 
• The well will be yellow on the plate 

graphic. 
• The ISTD which is out of range will 

appear in yellow in the analyte list. 
• The corresponding analyte will also 

be highlighted in yellow in the results 
table in MetSTAT. 
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5.5.2.2 ISTD Graph (other wells) 

Explanation Example 

For all other samples, the ISTD graph 
shows upper and lower limits as well as 
the measured cps values. The ISTD 
graph will be shown when selecting the 
ISTD tab. 
 
 
If an ISTD is out of range: 
• The well will be yellow on the plate 

graphic. 
• The ISTD which is out of range ap-

pears in yellow in the ISTD list. 
• The corresponding analyte will also 

be highlighted in yellow in the results 
table in MetSTAT. 
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5.5.2.3 Standards Graph 

Explanation Example 

The calibration standards (STD) graph 
shows the accuracy of the Biocrates cali-
bration standards. The accuracy is de-
fined as: 

𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑚𝑚𝑐𝑐𝑐𝑐𝑚𝑚𝑚𝑚𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
𝑚𝑚𝑒𝑒𝑒𝑒𝑚𝑚𝑐𝑐𝑐𝑐𝑚𝑚𝑚𝑚 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑚𝑚𝑐𝑐𝑐𝑐𝑚𝑚𝑚𝑚𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 𝑒𝑒 100 

 

The maximum and minimum tolerance 
values set by the OP are shown in red. 
 

If a standard is out of range: 
• The well will be yellow on the plate 

graphic. 
• The analyte which is out of range ap-

pears in yellow in the analyte list. 
• The analyte will be highlighted in yel-

low in the results table in MetSTAT. 
 

When you click on the analyte in the An-
alytes table, the analyte will be marked 
with a vertical line in the graph. 
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5.5.2.4 QC Concentration Graph 

Explanation Example 

This graph shows the accuracies of the 
quality control samples. The accuracy is 
defined as: 

𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑚𝑚𝑐𝑐𝑐𝑐𝑚𝑚𝑚𝑚𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
𝑚𝑚𝑒𝑒𝑒𝑒𝑚𝑚𝑐𝑐𝑐𝑐𝑚𝑚𝑚𝑚 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑚𝑚𝑐𝑐𝑐𝑐𝑚𝑚𝑚𝑚𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 𝑒𝑒 100 

 

The maximum and minimum tolerance 
values set by the OP are shown in red. 
 

If an accuracy value is out of range: 
• The well will be yellow on the plate 

graphic. 
• The analyte which is out of range ap-

pears in yellow in the analyte list. 
• The analyte will be highlighted in yel-

low in the results table in MetSTAT. 
 

If you click on the analyte in the Analytes 
table, the analyte is marked in the graph. 

 

 

 
Whenever a QC was injected in replicates from the same well position (injection replicates), 
the first injection is evaluated in MetVAL. 
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Explanation Example 
 

QCs in FIA part – Quant 500, p180, p400 HR and p150 Kit: 
Some analytes checked with the QCs may not be quantitative, e.g. lysoPC a C18:0 in KIT3. Their 
Analyte Classification is “Relative Quantitative“ and the values in "Expected Concentration" for these 
analytes are in arbitrary units. However, their accuracy is checked. 

 
 

Reason: The absolute analyte concentration of “Relative Quantitative” analytes cannot be determined, 
as external standards or reference materials are not available. However, based on numerous analyses 
these analytes show good CVs and highly reproducible concentration values. Consequently, they can 
be analyzed precisely but maybe not accurately. The resulting analyte classification is “Relative Quan-
titative”. The accuracy given in MetIDQ™ is the deviation from the determined analyte target concen-
tration. 
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5.5.2.5 QC-Median Concentration Graph 

Explanation Example 

When a QC level was measured in repli-
cates over the Kit plate, this graph shows 
the median accuracies. 
 

If a median accuracy value is out of 
range: 
• The well will be yellow on the plate 

graphic. 
• The analyte which is out of range ap-

pears in yellow in the analyte list. 
• The analyte will be highlighted in yel-

low in the results table in MetSTAT. 
 

If you click on the analyte in the Analytes 
table, the analyte is marked in the graph. 
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5.5.2.6 Analyte Concentration Graph 

Explanation Example 

The concentration graph of all analytes is 
shown for all samples. 
 
The lower limit of quantitation (LLOQ), 
and the upper limit of quantitation 
(ULOQ) are shown in red. These values 
are also listed in the Analytical Specifica-
tions. 
 
 
 
Information on all analytes is shown in 
the table left to the graph. The status is 
color-coded and explained on the next 
pages. 

 

 
 
* Concentrations are isotope corrected (FIA part only) 

The status of C10* is < LLOQ; name and 
measurement status are colored blue. 
The analyte classification is Quantitative, 
and the concentration value is below 
LLOQ, but above the limit of detection 
(LOD). 

 



Page 100 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

Explanation Example 

The status of Asp is Valid; name and 
measurement status are colored green, 
which means the concentration value is 
within the quantitation range. 
The analyte classification is Quantitative 
with Restrictions: poorer precision ex-
pected (CV=15-30%) 

 

The status of C18:1* is Valid; name and 
measurement status are colored green. 
The analyte classification is Relative 
Quantitative, and the concentration value 
is above the LOD. 
Note: LLOQ and ULOQ values are not 
defined for relative quantitative analytes. 

 

The status of C18:1-OH is < LOD; name 
and measurement status are colored pur-
ple, which means that the concentration 
value is below LOD. 
The analyte classification is Relative 
Quantitative: precise (CV<15%) but ac-
curacy not verified (FIA part only). 
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Explanation Example 

The status of Ser is STD/QC > Limit; 
name and measurement status are col-
ored yellow. 
The analyte classification is Quantitative, 
but the accuracy of Ser is not within the 
acceptance range for Ser in this QC 
measurement. 
Note: STD/QC > Limit or STD/QC < Limit 
is only displayed for QC samples. 

 

 

* Concentrations are isotope corrected (FIA part only) 
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5.5.2.7 Measurement Status 
A measurement status is given individually for each metabolite sample per sample. Analytes 
and internal standards (ISTD) are evaluated separately. Different Measurement Status values 
are available for Calibration Standards and Quality Controls or Samples and Zeros. According 
to their relevance, measurement statuses are prioritized. Only the Measurement Status of 
highest priority is shown in MetIDQ™. 
 

 ISTD (internal standard) – all samples: 
 

Measurement Status Sample Description 

 blank background noise in range 

 blank background noise above limit 

 

all 
except 
blank 

ISTD intensity in range 

 

all 
except 
blank 

ISTD intensity not in range 
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,  STD (Calibration Standards) and QC (Quality Controls): 
 

Measurement Status Description 

 accuracy in range 

 concentration below zero, e.g. -0.535 µM 

 concentration below LOD 

 concentration below LLOQ 

 concentration above ULOQ 

 concentration cannot be calculated, also see  

 
no measurement available 

 ISTD intensity not in range 

 accuracy below limit 

 accuracy above limit 

 analyte excluded by user in MetIDQ™ or during quantitation 

 

1. No measurement (concentration data) available for one 
well. 

2. Accuracy cannot be evaluated. 
  

https://support.biocrates.com/tiki-index.php?page=MS+Instrument+Software&highlight=no%20intercept
https://support.biocrates.com/tiki-index.php?page=MS+Instrument+Software&highlight=no%20intercept
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 Samples and Zero Samples: 
 

Measurement Status Description 

 concentration between LLOQ and ULOQ 

 concentration below zero, e.g. -0.535 µM 

 concentration below LOD 

 concentration below LLOQ 

 concentration above ULOQ 

 concentration cannot be calculated, also see  

 
no measurement available 

 ISTD intensity not in range 

 analyte excluded by user in MetIDQ™ or during quantitation 

 No measurement (concentration data) available for one well. 

  

https://support.biocrates.com/tiki-index.php?page=MS+Instrument+Software&highlight=no%20intercept
https://support.biocrates.com/tiki-index.php?page=MS+Instrument+Software&highlight=no%20intercept
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5.5.2.8 Analyte Classification 
A validation status is given for each analyte. For detailed information refer to the Analytical Speci-
fications document (AS_p180_#.pdf). 

Analyte Classification Description 

 
Validation criteria fulfilled. LC-part: 7-point calibration. FIA-part:  in-
ternal 1-point calibration. 

 
Also “Quantitative”, but poorer precision expected (CV=15-30%) 
and/or poorer accuracy expected (accuracy=15-30%) 

 
FIA part only: precise (CV<15%) but accuracy not verified. Internal 
1-point calibration. 

 Analyte not tested during validation. 

 
When is a metabolite classified as quantitative or relative-quantitative? 

 
 

Quantitative: verification of precision (CV) and accuracy according to validation criteria 
  

Relative Quantitative: 
verification of precision (CV) according to validation criteria 
verification of accuracy not possible, as no external standards available 
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5.5.2.9 Exclude Analytes or Wells from Validation 

Analytes or wells can be excluded from validation. Their Measurement Status is . This 
may be required, e.g. when a sample was pipetted incorrectly onto one well position or the 
incorrect retention time (RT) was defined for one analyte. 
 

Step Instructions Example 

1 In MetVAL > Validation select a well. 

 

2 Select the tab Analyte or ISTD.  or  

3 
Select an analyte (e.g. ADMA) and double-
click on the note field.  

4 

1. Select a Note Type. 
2. Enter a note, e.g. the Validation 

Note “RT was defined incorrectly”. 
3. Make a choice from which well or 

sample type analyte(s) should be 
excluded from validation. 

 Find a description below. 
4. Activate the status Invalid. 

 
Note: If the status Invalid is not activated, 
only a note is saved. 
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 Choice Result 

 

 

1. Make your choice of well(s). 
2. Analyte(s) listed in the column 

Linked Protocols are excluded 
from validation of the selected well. 

Note: If injection replicates were done, 
this selection affects all injection repli-
cates of the well. 

 
 

Analyte(s) listed in the column Linked 
Protocols are excluded from validation 
in the selected injection of a well. 

  
Chosen analyte of selected injection of 
a well is excluded. 

 
 

Analyte(s) listed in the column Linked 
Protocols are excluded from validation 
of the selected sample type, e.g. QC 1. 

 
 

Analytes listed in the column Linked 
Protocols are excluded from validation 
in all samples on the selected Kit plate. 

 
 

Inverse metabolite selection: 
1. select a plate run 
2. select metabolites that should not 

be excluded from validation 
3. select the “Status” Invalid 
4. click OK 

Example: If creatinine is selected, all 
further metabolites of a plate run get 
the status Invalid. 

 At least two plate runs are required. 
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Step Instructions Example 

5 Select OK in the “Note Editing” window.  

6 
To apply all changes, click on Validate to re-
validate the Kit plate.  

 
While the validation status Invalid can be changed at any time, validation notes cannot be 
edited but deleted. 
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5.5.3 MetVAL – QC Monitoring Graphs 

 
QC Evaluation page 109 

QC Trend page 110 

STD Trend page 111 

 

 

MetIDQ: QC and Calibration Standard Monitoring, Time-Dependent Quality Con-
trol 

 
Step Instructions Example 

1 

In order to obtain a QC analyte evaluation 
based on the EMA guidelines select the QC 
Evaluation tab. The Kit validation from 
MetVAL is used to classify each QC analyte. 
It is valid if the accuracy is within the prede-
fined ranges for a Kit. Otherwise the reason 
is displayed, e.g. STD/QC > Limit. 
If an analyte (see column Analyte Evalua-
tion) meets the EMEA criteria it is highlighted 
in green (status: valid), otherwise it is 
marked in yellow (status: invalid). For further 
details please have a look at the EMA guide-
lines on bioanalytical method validation (Eu-
ropean Medicines Agency, 2011). 

 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
http://www.ema.europa.eu/ema/index.jsp?curl=pages/includes/document/document_detail.jsp?webContentId=WC500109686%26mid=WC0b01ac058009a3dc
http://www.ema.europa.eu/ema/index.jsp?curl=pages/includes/document/document_detail.jsp?webContentId=WC500109686%26mid=WC0b01ac058009a3dc
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Step Instructions Example 

 

The QC Evaluation can be made for one Kit 
plate only. In MetVAL > Validation, select a 
Kit plate first and then switch to QC Monitor-
ing > QC Evaluation. 

1. 
 

2. 
 

2 

Select the QC Trend tab to obtain an over-
view of the inter-plate CVs of a selected QC 
analyte. This tool can be used to monitor the 
assay and instrument performance or repro-
ducibility over a specified time period. 

 

 

3 
In the top left panel Value Type define the 
type of value (e.g. concentration) you would 
like to monitor.  

4 
Use the Filter  to monitor a certain QC 
level by the QC’s bar code or use other filter 
options. 

 

5 
Use the button Table View (bottom left) to 
show.  
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Step Instructions Example 

 

The time period is predefined to 12 months 
by default in the Filter options and can be 
changed in the MetIDQ™ settings (Settings 
> MetVAL > QC Monitoring Settings). 

 

6 

In the Filter panel define the analyte and 
sample type you would like to monitor in the 
Trend Chart view. Graphs will be generated 
according to this selection.  

7 

Select the STD Trend tab to obtain an over-
view of the inter-plate CVs and concentra-
tions of a selected calibration standard level. 
This tool can be used to monitor the assay 
and instrument performance over a specified 
time period. 

 

 

8 According to step 5, use the Filter Option  
to specify a Standard level or set. 

 

9 

In the panel Filter define the analyte and cal-
ibration standard level you would like to 
monitor in the Trend Chart view. Graphs will 
be generated according to this selection.  
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5.5.4 MetVAL – Analyte Overview Graph 

 
 

 

MetIDQ: QC and Calibration Standard Monitoring, Time-Dependent Quality Con-
trol 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

1 

Select the Analyte Overview tab and 
choose Analyte . Analyte per ana-
lyte the values 
 

• Concentration: blue dots  
• Retention Time:  orange quadran-

gles  
• Peak Area (LC):  green triangles  
• Intensity (FIA): green triangles  

 

are shown for the chosen Kit plate. 
 
Note: No retention times ( ) are available 
in FIA part. 

LC part: 

 

 
FIA part: 
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Step Instructions Example 

2 

Select the Analyte Overview tab and 
choose ISTD . Analyte per analyte 
the values 
 

• Retention Time:  orange quadran-
gles  

• Peak Area (LC):  green triangles  
• Intensity (FIA): green triangles  

 

are shown for the chosen Kit plate. 
 
Note: No retention times ( ) are available 
in FIA part. 

LC part: 

 

 
FIA part: 

 

3 
Use filter: choose analyte class or sample 
type.  
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6 Export Results, Data Monitoring and Statistical Data Evaluation 
In MetSTAT all Kit results can be compiled and displayed. From MetSTAT results can be saved 
directly as Microsoft™ Excel™ worksheet. It can also be saved in other file formats (e.g. .txt, .xml 
or .csv) for further data evaluation. For data transfer into MetaboAnalyst a specific export options 
are available. If you are using the statistics software “R”, please read the Biocrates® user manual 
“RMetIDQ_1.pdf” which describes how to load the Kit data into “R”. 
In this section you will learn how to configure a report. First select a Report Context, then choose 
the samples you want to include and choose the report layout for your data. Finally, you can export 
the data. 
 

 

Report Context and Statistical Plots (MetSTAT > Display Data > Plots) 
MetIDQ: Statistical Plots and Report Context in MetSTAT 
 

Report Context, Data Normalization and Ratio Explorer 
MetIDQ: Report Context, Data Normalization and Ratio Explorer 
 

 
Step Instructions Example 

1 Click the MetSTAT button. 
 

2 

First you have to choose your Report Con-
text. In a Report Context all linked samples 
and your MetSTAT settings (including Stat-
Pack) will be saved. 
You can either use the DEFAULT Report Con-
text or create a new report context. 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

 

If you are not interested in using the Report 
Context feature, keep the Report Context 
“DEFAULT(labadmin)” active and continue 
with step 5 (Select Samples). 

 

3 

To create a new Report Context, click New 
and enter a new name. Choose a “Condition” 
and the “Visibility” for the Report Context. The 
Description field is optional. 

 

 
 Choice Explanation 

 Condition 

If the condition is set to Pending, changes 
that are made will be saved in the Report 
Context. If the condition is set to Approved, 
changes will not be saved. 
Note: if the Condition is set to Approved, you 
cannot link or unlink samples in the Select 
Samples tab (steps 5-7). This is only possi-
ble when the Condition is set to Pending. 

 Visibility 

The visibility can be set to Private or Global. 
Private: The Report Context is only visible for 
the MetIDQ™ user who creates it. 
Global: The Report Context is visible for all 
MetIDQ™ users. 
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Step Instructions Example 

4 
Activate the checkbox of the Report Context 
that shall be used.  

5 Next, choose the Select Samples tab. 
 

6 
Choose the samples for data evaluation and 
move them to the Linked Sample list using 
the transfer bar. 

 

7 

 
You can use the filter before you choose sam-
ples. Use the Filter button in the upper right 
corner to open the filter tool. 
 

Click on the column header to sort any col-
umn. The direction of the grey triangle tells 
you the sorting order; either ascending (trian-
gle is pointing up) or descending (triangle is 
pointing down). 

  

 

 
 

 

8 Click on Display Data and select the Data tab. 
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Step Instructions Example 

9 

You will see the sample table including all 
sample information and metabolite concentra-
tions. Use the scroll bar at the bottom of the 
window to navigate to the right, showing all the 
columns in the table.  

 

10 

 

 
Change the sort order in any column by click-
ing in the column header. 
 
 
Here, the column sort criteria for Sample bar-
code has been changed. 
 
Note: You may also sort data by more than 
one column. Hold the Ctrl key pressed and 
click on the column header which shall have 
the highest priority, for example Sample bar-
code. Click on the column header you also 
want to sort, for example Well position. 
The sample table is then sorted by Sample 
barcode then by Well Position. 
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Step Instructions Example 

 

Each sample status has its own color. Drag 
the mouse cursor over a sample to see the 
status. 
Here, the blue color indicates that the value of 
0.256 has the status < LLOQ (below Lower 
Limit of Quantification). 
Values written in Italic are isotope corrected 
(FIA only). 

 

11 

 

The rows with active checkboxes will be ex-
ported. Press and hold the Ctrl key and click 
on the rows you want to select. Right click to 
see the context menu and select an option. 
 
To hide columns and exclude them from ex-
port, click on the column setup button (as 
shown on the right). Double-click on the col-
umn names in the list that you want to dese-
lect. Double-click again will reselect the col-
umn. 

 

 



Page 120 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

Step Instructions Example 

12 

Value Type 
Select the data type that is displayed in the 
main table. The default option is Concentra-
tion. 

 

 

Analyte Peak Area, Analyte Retention 
Time and Internal Std. Retention Time 
are not available for FIA data. 

13 
Display Options 
Specify analyte class, Bio IDs, Analytical De-
tails and the Display Unit. 

 

 

We have implemented a direct link to public 
available databases like the Human Metabo-
lome Database (HMDB) 
(http://www.hmdb.ca/) or LIPID MAPS (LMID) 
(http://www.lipidmaps.org/), which you can se-
lect as shown on the right. The Bio ID com-
pound identifiers are then shown in the results 
table. 

 

 Available Bio IDs are shown in a table.  

http://www.hmdb.ca/
http://www.lipidmaps.org/
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Step Instructions Example 

 

Activate this option to show 
• LLOQ (Lower Limit of Quantitation) 
• ULOQ (Upper Limit of Quantitation) 
• OP (used OP for Kit measurement) 
in the report table. 

 

 

You can choose between several different dis-
play units in the drop-down menu. 
• Using the Tissue option (see page 57) se-

lect “pmol/mg Tissue” 
• Using the Cells option (see page 58) select 

“pmol/10E6 Cells” 
 

14 

Split/Merge Acquisitions 
You can split the positive and negative ion 
mode injections of each plate (if available, e.g. 
p180 Kit FIA part) into two rows for each sam-
ple in the results table. For this, click on the 
corresponding acquisition and click Split. 

 

 

15 
Now the sample data is displayed in two rows: 
one for positive, one for negative ion mode re-
sults.  

16 
To merge the rows again, select both injec-
tions and click Merge.  

 

When you inactivate the checkbox, the FIA 
and LC run for each Kit plate will be split (if 
available, e.g. p180 Kit). You obtain two rows 
for each sample, one containing the FIA re-
sults and one containing the LC results. 
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Step Instructions Example 

 
Comparability of results generated with different kits: 
For best comparability of results generated with different kits, e.g. Quant 500 and p180 Kits, perform 
a Normalization versus Target Values of all datasets, using a Biocrates® QC as Sample Source. 

17 

Data Normalization 
When measuring several Kit plates, slight in-
ter-plate variations my occur. Therefore, an in-
ter kit plate data normalization is recom-
mended. To normalize a set of data 
1. Link all samples (at least samples and 

QCs) from all Kit plates their data should 
be normalized to Select Samples. For ex-
ample, create a new Report Context as de-
scribed at the beginning of this section 6. 

2. Go to Display Data > Data. 
3. Open the tab Data Normalization (shown 

on the right) and activate “Normalize Sam-
ple Concentration Data”. 

Details to this feature are given below and in 
7.1 Data Normalization, page 133. 

 

 

 Choice Explanation 

  Activate to perform data normalization. 

  Save normalization report as PDF document. 

  
For normalization select all plates or one spe-
cific plate as reference. 

  Select a reference sample, e.g. QC Level 2. 
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To perform normalization across different QC 
batches, use this option, see Appendix 7.1. 

  Use Normalization vs. Target Values if QC from different batches were used. 

 
 

For normalization concentrations form QC 
samples in replicates, e.g. QC Level 2, are 
averaged. Use “Mean” or “Median”. 

  Perform a log-transformation. 

  Used with p150 or p180 Kit for urine samples. 
 

Step Instructions Example 

 

Requirements for Data Normalization: 
• The currently active MetIDQ™ “Report 

Context” condition has to be “Pending”. 
• The same sample type which is used for 

normalization (selected “Sample Source”) 
must be measured on all loaded Kit plates, 
e.g. QC level 2. 

Note: When Normalization vs. Target Val-
ues is used, QCs from the same batch are no 
longer required! 
• The used “Sample Source”, e.g. QC level 

2, has to loaded together with the samples 
in Display Data > Data. 

• The “Sample Source” has to be measured 
at least in the number of replicates, that is 
defined in Settings > MetSTAT (see 7.4. 
Changing Settings in MetIDQ™ Software). 

 

 
 
 
 
 
 
 
 
 

 



Page 124 MetIDQ™ Oxygen 

MetIDQ™ Oxygen 

Step Instructions Example 

 

Creatinine Normalization: 
A creatinine normalization is recommended 
when urine samples were analyzed. For urine 
samples the AbsoluteIDQ® p180 Kit for Urine 
or the AbsoluteIDQ® p150 Kit for Urine are re-
quired. 
To perform a Creatinine normalization, link the 
samples in MetSTAT > Select Samples, go 
to MetSTAT > Display Data and activate the 
checkbox “Creatinine Normalization”. All me-
tabolite concentration values will be divided by 
the creatinine concentration, sample per sam-
ple. 
 
AbsoluteIDQ® p180 Kit for Urine: 
Related samples from the FIA and LC part 
must be linked together (MetSTAT > Select 
Samples). 
 
Note: The checkbox can only be activated if 
creatinine was measured with all linked sam-
ples. 
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Step Instructions Example 

 

Subtract Median Concentration of Zero Sam-
ples (recommended for FIA part only) 
When activating the checkbox, the median 
concentrations of the zero samples are sub-
tracted from the concentrations of the samples 
(samples only, not QCs or Calibration Stand-
ards). This is an optional feature and should 
be selected if you have samples with very low 
metabolic concentration levels, like in cerebro-
spinal fluid (CSF). It is only active if you have 
selected the zero samples from the plate you 
are analyzing (see page 117). 

 

18 

To export data as displayed in MetSTAT, use 
the settings as shown on the right. Two differ-
ent example reports are given on page 129. 
Further formatting choices are explained in 
the table overleaf. 
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 Choice Result 

 Transpose values Transpose (interchange) rows and columns. 

 Add comments to Excel™ files 

Add Status, e.g. < LOD, as a comment. 

 

For large data exports do not use this 
option. Otherwise the exported file may 
not be compatible with old Excel ver-
sions. 

 Export Status Information 
Add Status, e.g. < LOD, to .csv or .txt files in 
an additional column per analyte. 

 Export all types of values at once 
Includes all “Value Types” (Concentration, 
Analyte Intensity, Accuarcy, etc.) in one ex-
port file. 

 Replace values of 

You can replace values of a certain status 
with any text or number for the report. For ex-
ample, you can replace concentration values 
with the status < LOD with 0. Activate the 
checkbox and double click the field cell in the 
“with” column. Now you can type in a text of 
your choice. If no text is defined in the cell the 
concentration values will be replaced by the 
status (i. e. “< LOD”). 

19 

When you are ready to export the data, click 
Export. You can save the data in different for-
mats as shown on the right. Please find export 
examples in section 6.1  
Available Report Formats, page 128. 
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Export of MS raw files: 
MS raw data files, stored in the MetIDQ™ da-
tabase, can also be exported in this step (LC 
data are only available if they were imported, 
see section 5 Quantitation)  

 

To change the decimal separator symbol, go 
to the MetSTAT settings. 
See 7.4 Changing Settings in MetIDQ™ Soft-
ware (page 139). 
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6.1 Available Report Formats 
MetIDQ™ offers different export options (see step 14 above). The export contains all information 
(e.g. sample concentrations) as displayed in MetIDQ > Display Data > Data. Below you will find 
some export examples. A MetaboAnalyst compatible format is also available. 
Standard Report (.csv or .txt) 

 
 
Microsoft™ Excel™ Report (.xlsx or .xls) 

 



6. Export Results, Data Monitoring and Statistical Data Evaluation Page 129 

 

Table Formatting Examples 

Type Description 

Excel™ The color coding as given in MetSTAT is shown in the worksheet as well. 

.csv 

.txt 
MetSTAT color coding is not retained. Additional columns are added to show the status. 

 

Transposed Values Report Examples 
Non Transposed (Excel™ Report) 

 
Transposed Values Report (Excel™ Report) 
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6.2 Inter-Kit measurement monitoring 
In MetSTAT > Display Data > Plots the Kit measurements can be monitored over time in order to 
compare the results from Kit to Kit. For example, plate effects that can be caused by the instrument, 
Kit preparation, or sample matrix can be visualized here. LOD, Blank, Zero, Calibration Standard, 
QC, and Real Sample concentrations are displayed analyte by analyte for every chosen Kit plate. 
Finally, a graphical summary can be created. 

 

MetIDQ: Statistical Plots and Report Context in MetSTAT 

 
Step Instructions Example 

1 

Go to Select Samples and use the filter option 
 to select the Kit runs you want to monitor. 

 

Information: Select a time window (e.g. 
2015/01/01 till 2015/12/31) to monitor the Kit 
measurements stability. 

 
 

 

2 
Click on Display Data and select the Plots 
tab.  

 
 

3 

LOD, Blank, Zero, Calibration Standard, QC, 
and Unknown Sample concentrations are dis-
played analyte by analyte for every chosen Kit 
plate. The Unknown Sample concentrations 
are displayed as black boxplots. 
The symbols in the graph are explained in the 
Chart Key (lower left side). 

 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

4 

1 Use the table Metabolites to page through 
all available analytes. 

2 Concentration values of all samples per Kit 
plate (blue arrow) are visualized in the 
form of box plots in the Chart Key pane. 

1 

 

2 

 

5 
Use the Export Charts button to create a 
graphical report in PDF format.  

6 

The PDF report consists of one graph per 
page for every analyte. For an overview, it 
might be useful to print multiple graphs (i.e. 
multiple analytes) per page. 
Print multiple graphs: 
• Open the report with the Adobe® Reader® 

(version 10 or higher recommended) 
• File > Print… (Ctrl + P) 
• Select the number of pages you would like 

to print per sheet (see screenshot) 
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7 Appendix 

7.1 Data Normalization – Based on QC Target Values 
For data normalization of unknown samples, Biocrates QCs can be used. In order to guarantee a robust 
data normalization, we recommend analyzing BIOCRATES QC level 2 in replicates, at least of 4. If QCs 
were run in less replicates than 3, please refer to page 140 to adapt MetSTAT settings. To perform a 
data normalization, select and link all BIOCRATES QC and unknown samples of the Kit plates in 
MetSTAT > Select Samples. Be aware that data normalization will change the displayed concentration 
values. Data normalization can be undone by deactivating the checkbox. 
Note: Biocrates® QCs from different production batches can be used. 
 

1. Select a Plate Source for normalization. 
All: average values of all linked plates are used for normalization. 
Specific plate: values of the selected plate are used as reference for normalization. 

2. Select a Biocrates® QC in the Sample Source field. 
3. Activate the option Normalize vs. Target Values. 
4. For average concentration calculations of replicates, select the algorithm median or mean for data 

normalization in the Method field. We recommend using the median. 
 

- Data Normalization does not overwrite original Kit plate concentration data. 
- To use non-BIOCRATES QC samples, refer to 7.2. 

 

The following steps describe how the data normalization is carried out by MetIDQ™: 
a. Analyte by analyte and for every Kit plate, the median or mean values (if above LOD) of the se-

lected sample source are calculated, hereinafter referred to as A. For plate 1 the value A1 is cal-
culated, for plate 2 the value A2, and so on. 

b. Per analyte and per QC level batch, one concentration Target Value (TV) is available in the Met-
IDQ™ database, e. g. TVb1 for QC batch 1. 

c. The ratio Ab1/TVb1 is calculated and represents the correction factor for each Kit plate where QC 
batch 1 was used, hereinafter referred to as Cb1. In detail, C1b1 = A1b1/TVb1 is the correction factor 
for an analyte on Kit plate 1, C2b1 = A2b1/TVb1 is the correction factor for an analyte on Kit plate 2, 
and so on. 

The metabolite concentrations are finally normalized by dividing each concentration value by the cor-
rection factor Cb1, e.g. c(analyte, plate1)normalized = c(analyte, plate1) / C1b1(analyte).  
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7.2 Data Normalization – Based on Reference Sample 
For data normalization of unknown samples, results of a QC sample can be used as reference. In order 
to guarantee a robust data normalization, we recommend analyzing BIOCRATES QC level 2 or your 
own QC sample in replicates, at least of 4. If QCs were run in less replicates than 3 please refer to page 
140. To perform a data normalization, select and link all QC and unknown samples of the Kit plates in 
MetSTAT > Select Samples. Be careful as the data normalization will change the displayed concen-
tration values. Data normalization can be undone by deactivating the corresponding checkbox. 
 

1. Select a Plate Source for normalization. 
All: average values of all linked plates are used for normalization. 
Specific plate: values of the selected plate are used as reference for normalization. 

2. Select a Biocrates® QC or any of your samples in the Sample Source field. 
3. Deactivate the option Normalize vs. Target Values. 
4. For average concentration calculations of replicates, select the algorithm median or mean for data 

normalization in the Method field. We recommend using the median. 
 

- Data Normalization does not overwrite original Kit plate concentration data. 
- Every sample that was measured with all linked Kit plates (MetSTAT > Select Samples) can be used 

as sample source for data normalization. This offers the flexibility to use own QC samples. 
 

The following steps describe how the data normalization is carried out by MetIDQ™: 
a. Analyte by analyte and for every Kit plate, the median or mean values (if above LOD) of the se-

lected sample source is calculated, hereinafter referred to as A. For plate 1 the value A1 is calcu-
lated, for plate 2 the value A2, and so on. If the selected sample source has been pipetted only 
once onto a Kit plate, there is only one value per analyte. 

b. Analyte by analyte, the overall median or mean value across all selected plates is calculated, here-
inafter referred to as B. 

c. The ratio A/B is calculated and represents the correction factor for each Kit plate, hereinafter re-
ferred to as C. In detail, C1 = A1/B is the correction factor for an analyte on Kit plate 1, C2 = A2/B 
is the correction factor for an analyte on Kit plate 2, and so on. 

d. The metabolite concentrations are finally normalized by dividing each concentration value by the 
correction factor C, e.g. c(analyte, plate1)normalized = c(analyte, plate1) / C1(analyte).  
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7.3 Define Groups and Variables in MetLIMS 

 
MetIDQ Project Start: Sample Registration, Groups, Varia-
bles 

 
Step Instructions Example 

1 
Choose the Sample Registration tab in 
MetLIMS.  

2 
Look at the lower panel in the Sample Regis-
tration window. Click on Groups and Config-
ure. 

 

3 
You will see the Groups Configuration win-
dow. 

 

4 Click New in the Categories panel.  

5 

You will see the New Category window. 
 
Name the category. Here it is gender. The De-
scription field is optional. Click OK when fin-
ished.  

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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Step Instructions Example 

6 
You will see the new category listed. Click New 
in the Groups panel. 

 

7 

In the New Group window, add a group that be-
longs to the selected category. Here, female is 
added as a group in the gender category. 
 
Click OK when finished. 
 
Repeat the process to add more groups, e.g. 
male.  

8 

This category now has two groups. 
 
Category: gender 
Groups: female, male 
 
Click Close. 
 
Note: there is no limit on the number of groups 
which can be added to a category. 
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Step Instructions Example 

9 

When the categories and groups are defined, 
you can link them to samples. Select the sam-
ples in the sample table and link a group to the 
samples using the transfer bar. You can also 
import samples and add group information in 
one step as described in section 4.1.3.3 (page 
42). 
Note: there is no limit on the number of groups 
that can be linked to a sample. However, only one 
group of each category can be added to a sample. 
For example, you cannot add male and female to 
the same sample, but you can link male from the 
category gender and for example diseased from 
another category to the same sample. 

 

10 

To add numeric information (age, amount of 
treatment etc.) to the samples, define a new 
variable. Click on the Variables tab and on 
Configure.  

11 
This will open the Variables Configuration 
window. 
Click New. 

 

12 
You will see the New Variable dialogue. Type 
in a name for the variable. The field Unit is op-
tional. 
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Step Instructions Example 

13 Choose a data type from the drop-down menu. 
 

14 
Here, the new variable is age. The Unit is years, 
and of datatype is Number. 

 

15 
Next, link the variable to the samples as de-
scribed in step 9 on page 137. Click on the sam-
ple name in the Linked Variables list. 

 

16 
The variable age is now linked to the samples 
105086 and 105090.  

17 
You can change the Value by double clicking 
the cell and typing in another value. Here 
65,000 is specified as the new value.    

 
For sample registration: Refer to section 4.1.3, page 33.  
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7.4 Changing Settings in MetIDQ™ Software 
For more information watch the following video tutorial: 

 

MetIDQ Toolbar and General MetIDQ Settings 

 
Step Instructions Example 

1 
Click on the settings button in the MetIDQ™ 
toolbar.  

2 Click on the MetSTAT tab. 
 

3 

Select the decimal separator “.” or “,” from the 
drop-down menu. 
The number of decimal places displayed in 
MetSTAT can be defined blow. 

 
 

https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
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 Choice Explanation 

  0.081 

  0.331 

  8.23 

  11.0 

  893 

 
 

Defines the minimum of replicates on every 
Kit plate for normalization. 

 
 

If you activate this checkbox, analytes with 
missing concentration values (empty com-
binations) will not be shown in StatPack 
graphs. 

 
 

Defines the path where the “Rscript.exe” is 
located. 
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7.5 MetIDQ™ Software Update 
A MetIDQ™ update will be provided with a USB stick shipped with a kit or by our Customer 
Support. During the update process the current MetIDQ™ version will be replaced. To check 
the current MetIDQ™ version and build number click 

 
 Version Info e.g. 

 
 

Step Instructions Example 

1 
Double click on the MetIDQ™ install file on the 
USB stick and follow the installation instruc-
tions below.  

MetIDQ-…-install.exe 

2 
Select “Yes, update the existing installation”. 
 

Follow the instructions of the Install Wizard. 
 

3 

Your current MetIDQ™ version will be un-in-
stalled and the new version installed. 
It is recommended to “Keep all currently 
stored MetIDQ™ user preferences”. 
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Step Instructions Example 

4 

Start MetIDQ™, connect to the kit database 
(default: “Kit Database”) and log in as user 
with administrative rights, e.g. 
 

Username: labadmin 
Password: 12345678  

 If a database update is required, do steps 5 - 8. 

 

 
A database backup is highly recommended as described in section 7.6.1 Database Backup / 
Export, page 143, before starting the database update process. 

5 
The password metkit 
is required for the update process. 

 

6 

The update process may take several 
minutes. 

  Never abort the update process! 

7 
After the update process close the Database-
Updater window and restart MetIDQ™. 

 

  



7. Appendix Page 143 

 

7.6 Backup, Restore, Transfer, Import or Update the MetIDQ™ Database 
All MetIDQ™ data are stored in an Oracle® database. Perform regular backups. 
 

 

To avoid data loss, perform regular backups. Save the backup file (.dmp) at a 
secure place (network drive, external hard drive, USB stick) physically separated 
from the PC on which the database is installed. 

 

7.6.1 Database Backup / Export 
Step Instructions Example 

1 
To generate a database backup, start 
MetIDQ™ and click on the database connec-
tions button. 

 

2 

Click the Create Backup button. When an 
User Interaction Window appears, click Yes. 
The backup will be written into an  Oracle® 
dumpfile (*.dmp). 

 

 

This process can take several minutes. When the process has finished, a backup report win-
dow opens. The path where the backup file (*.dmp) is located can be found at the end of the 
backup report window. 
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Step Instructions Example 

3 

The default backup file location for Oracle® XE 
is: 
C:\oraclexe\app\oracle\admin\XE\dpdump 
The default dumpfile name is: 
metkit_YYYY-MM-DD_hh-mm-ss.dmp 
 

Each backup file can be used for a database 
transfer to a second PC (see: 7.6.4 Transfer a 
MetIDQ™ Database to a Second PC) 
 

 

 

For a secure back up copy and store 
this file at a secure and physically 
separated place from the PC on which 
the database is installed. 

 

The backup file directory and a list of all back-
ups can be found in the Backup Manager 
(open the Database Connections window 
and select “Show Backups”). 

 

 

4 
To delete a database backup: 
Select a database backup and click Delete. 
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7.6.2 Database Import 
MetIDQ™ databases can be imported from a local, removable or network drive to the PC 
where MetIDQ™ is installed. 

Step Instructions Example 

1 Open the Backup Manager. 

 

 

2 Choose the Import button. 

 

3 
Select the MetIDQ™ backup file (*.dmp). 
Click Open. 

 

 
You will see the imported backup in the 
Backup Manager list. 
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7.6.3 Restore a Database 
This step is only necessary in case data has been lost, corrupted, or if you want to transfer a 
MetIDQ™ database to a second PC (see 7.6.4). You can load the backup file you have gen-
erated in previous steps to restore the original database. 

Step Instructions Example 

 The following procedure will erase your currently used MetIDQ™ database permanently! 

1 

To restore a database from a backup, select a 
database in the Backup Manager and select 
Restore. 
How to import a data base back up from an 
external source, see section 7.6.2 Database 
Import. 

 

2 
When the User Interaction window appears, 
click Yes. 

 

3 
Enter the database password “metkit”. Then, 
the restore process starts (this may take sev-
eral minutes).  
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7.6.4 Transfer a MetIDQ™ Database to a Second PC 
This option can be used to move MetIDQ™ and all Kit data to a second PC. 

Step Instructions Example 

1 
Install Oracle® and MetIDQ™ on the second 
PC according to section 2 Install MetIDQ™, 
page 11. 

 

2 
Perform a database export 
 7.6.1 Database Backup / Export, page 143 

 

3 
Import the database on the second PC 
 7.6.2 Database Import, page 145 

 

4 
Restore the backup at your new PC 
 7.6.3 Restore a Database, page 146 
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7.6.5 Update the METKIT Backup Admin 
The “Backup Admin” is used to perform METKIT database backups and imports. To keep the 
“Backup Admin” updated, an update may be necessary from time to time. 

Step Instructions Example 

1 

Run “import_metkit.bat”. as ad-
ministrator. 
The latest version is provided by 
the Customer Support.  

 

2 
Type “y” (yes) to update BIO-
CATES BACKUP ADMIN. 

 

3 
When the update process is 
completed, press any key. The 
Backup Admin is now updated. 

 

 The update process does not affect any concentration data in the MetIDQ™ database. 
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7.7 Import the metkit Database into Oracle® by DBAs 
Optional and for advanced users only: If an Oracle® database is already installed, following 
these instructions. A database administrator (DBA) may be required. 

Step Instructions 

1 
Find the metkit.dmp file in the USB stick folder “MetIDQ and Oracle\Installation Files”. This 
file contains the pre-configured “metkit” schema in tablespace “users”. The default password 
for the user METKIT is “metkit”. 

2 
Copy the dumpfile metkit.dmp to the “datapump” directory. 
e.g. $ORACLE_BASE\admin\$ORACLE_SID\dpdump 

3 

Import the dumpfile using Oracle® datapump. 
impdp system/password directory=DATA_PUMP_DIR 
 dumpfile=metkit.dmp schemas=metkit 
 remap_tablespace= users:Your_Tablespace 

7.8 Installing Database Patches 
After installing MetIDQ™, database patches can be applied. Follow the steps below: 

Step Instructions Example 

1 In the MetIDQ™ toolbar click Apply Database Patch. 
 

2 

Choose the desired database patch. MetIDQ™ will 
load it automatically into the MetIDQ™ database. 
Kit patch’s name example: 
MSmanufacture_KIT_DB###_Patch_YYMMDD.jar  

3 Click OK to complete the operation.  

 
Refer to the kit user manual to look up the required 
MetIDQ™ patch(es). 
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7.9 Alter Plate Runs to New OP (FIA Only) 
Step Instructions Example 

1 
Click on the Alter plate runs to new OP but-
ton in the toolbar.  

2 Use the Filter to select one or more Kit plates. 

 

3 

In the Alter Plate Runs To New OP window, 
double click the cell New OP of the plate you 
want to alter and choose the OP you want to 
apply.  

4 Click Alter.  
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7.10 Usage of the Tissue Factor Tool 
The Tissue Factor (TF) is defined as the ratio of extraction solvent volume and tissue volume (see 
equation 1). For this the following assumption is made: 1 mg tissue = 1 µL extraction solvent. 
 

(1)    TF = µL extraction solvent 
µL tissue

 
 

In order to calculate the Normalization Ratio (NR) the total extraction volume is taken into account. 
The Normalization Ratio (NR) is calculated according to equation 2. 
 

(2)    NR = TF + 1 µL tissue
1 µL tissue

= TF + 1
1

 
 

According to equation 3, the Normalization Ratios are used to calculate the normalized analyte 
concentration (c). 
 

(3) cnormalized(analyte) = NR x c(analyte) 
 

Normalized concentrations are displayed in MetSTAT. Navigate to MetSTAT > Display Data > 
Display Options > Display Unit and choose the option “pmol/mg Tissue”. The Tissue Factor 
normalization tool, which is part of MetIDQ™, is described in more detail below. 
 

Example for normalization of tissue extracts: 
 

Select your “Worklist” in the “Project Tree” of MetLIMS > Projects. In the section “Well List” you 
will find the column „µL/mg Tissue Factor“. Value “0” is entered by default and no normalization 
will be executed. Using diluted samples, please enter a value apart from “0”. For example, if you 
have added the 4-fold volume of extraction solvent to your tissue, enter “4” into the column “µL/mg 
Tissue Factor“. 
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As the tissue volume must be taken into account, the Normalization Ratio (NR) is calculated ac-
cording to equation (2). 
 

 NR = TF+1
1

= 4+1
1

= 5 
 

According to equation 3, all analyte concentrations form sample “G I subject 1” will be multiplied 
by 5 when selecting the display option „pmol/mg Tissue“ in MetSTAT (see below). 
 

 cnormalized(analyte) = NR x 5 
 

Subsequent data normalization by Tissue Factors: 
For subsequent data normalization, please select the corresponding plate in MetLIMS, change the 
“Condition” form “Approved” to “Pending” and click “Delete Measurements”. Afterwards enter the 
dilution factor values in the column “µL/mg Tissue Factor“. Then set the “Condition” back from 
“Pending” to “Approved” and go to MetCONC. Import your corresponding data files (FIA part) and 
import the result file (LC part) again. For further assistance please refer to chapter 5. 
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7.11 Usage of the Cell Normalization Tool 
When using cell lysis extracts the analyte concentrations can be normalized to the cell number and 
the used extraction solvent volume. For this the used number of cells and extraction volume can 
be defined for each sample on one Kit plate. The functionality of the Cell Normalization Tool is 
described by an example. 

Example You see in MetIDQ™ 
 

Sample Cell Number Cell Extraction Volume [µL] 
001 1 300 400 50 
002 5 700 100 50 
003 800 600 50 

 

 

 
 

Cell Number and Cell Extraction Volume can be defined in MetLIMS > Projects > Well List in the 
corresponding columns. In this manner, each sample extract’s analyte concentration (canalyte) can 
be normalized by the Cell Extraction Volume (Vextr) and the Cell Number (Ncells) according to equa-
tion 1. To deactivate this feature please enter “1” in both columns, “Cell Number” and “ Cell Ex-
traction Volume [µL]”. 
 

(1)    c𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐 = 𝑐𝑐𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑒𝑒∙𝑉𝑉𝑒𝑒𝑒𝑒𝑎𝑎𝑒𝑒 
𝑁𝑁𝑐𝑐𝑒𝑒𝑎𝑎𝑎𝑎𝑐𝑐

 
 

For sample #001 and the exemplary canalyte = 1.23 µM this will be: 
 

    c𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐(𝑆𝑆𝑚𝑚𝑚𝑚𝑒𝑒𝑆𝑆𝑚𝑚 001) = 1.23 µM∙50 µL 
1300400 cells

= 47.29 10
−18 𝑚𝑚𝑚𝑚𝑐𝑐
𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 
 

The cell number of the normalized amount of substance (ncells) can be considered, e.g. ncells per 
106 cells. 
 

    c𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐(𝑆𝑆𝑚𝑚𝑚𝑚𝑒𝑒𝑆𝑆𝑚𝑚 001) = 47.29 10
−18 𝑚𝑚𝑚𝑚𝑐𝑐
𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

= 47.29 𝑝𝑝𝑚𝑚𝑚𝑚𝑐𝑐
106𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 

    c𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐(𝑆𝑆𝑚𝑚𝑚𝑚𝑒𝑒𝑆𝑆𝑚𝑚 002) = 10.79 10
−18 𝑚𝑚𝑚𝑚𝑐𝑐
𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

= 10.79 𝑝𝑝𝑚𝑚𝑚𝑚𝑐𝑐
106𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 

    c𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐(𝑆𝑆𝑚𝑚𝑚𝑚𝑒𝑒𝑆𝑆𝑚𝑚 003) = 76.81 10
−18 𝑚𝑚𝑚𝑚𝑐𝑐
𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

= 76.81 𝑝𝑝𝑚𝑚𝑚𝑚𝑐𝑐
106𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
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The number of cells to which the amount of substance 
(ncells) should be normalized can be chosen in Settings 
> MetLIMS (see blue frame on the right). 

 

The Cell Normalization Tool does not affect the analyte 
concentration unit in the MetIDQ™ database (which is 
µmol/L by default). 

 
 

Subsequent use of the Cell Normalization Tool: 
For the subsequent use of the Cell Normalization Tool, please select the corresponding plate in 
MetLIMS, change the “Condition” form “Approved” to “Pending” and click “Delete Measurements”. 
Afterwards define the number of cells and extraction volume. Then set the “Condition” back from 
“Pending” to “Approved” and go to MetCONC. Import your corresponding data files (FIA part) and 
import the result file (LC part) again. For further assistance please refer to chapter 5.  
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7.12  Database connection troubleshooting 
MetIDQ™ requires a connection to an Oracle® database containing the user METKIT. An inactive 
connection is displayed in the login screen, as shown below. 
 

 
 

If the connection failed, perform troubleshooting. 

1. The port used by the Oracle® database is blocked 
Port 1521 is used. If MetIDQ™ and the database are installed on different computers, please 
verify that this port is open. 

In order to open a port in Windows 10, follow these steps: 
1. Using Windows 10, navigate to Control Panel > System > Security > Windows Firewall. 
2. Click Advanced settings and select “Inbound Rules” in the left pane. 
3. Right click “Inbound Rules” and select “New Rule”. 
4. Add port 1521. Click “Next”. 
5. Define rules for port 1521 and the protocols TCP/UDP in the next window. Click “Next”. 
6. Select “Allow the connection“ in the next window. Click “Next”. 
7. Select the relevant network type(s) and click “Next”. 
8. Name the rule and click “Finish”. 
 Repeat steps 1 – 8 for “Outbound Rules”. 
 Ports may be controlled by another firewall.  
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2. METKIT password expired 
After some time, the METKIT password may expire. Unlock the database using SQL com-
mands. 
- Run the SQL Command Line: in Windows go to All Programs > Oracle database ##g 

Express edition > Run SQL Command Line. 
- In the SQL Command Line, type the following commands: 

connect; 

username: system 

password: It is the password which was selected during Oracle® XE installation (see 
section 2.1 Install the MetIDQ™ Software). 

press ENTER 

 
- You are connected to the Oracle® database. To unlock the database, use the following 

SQL commands: 

alter profile DEFAULT limit PASSWORD_LIFE_TIME unlimited; 

alter user METKIT identified by metkit; 

alter user METKIT account unlock; 

commit; 

 

- Restart MetIDQ™ and check the database connection. 
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3. Oracle® Listener service was not started 
The Windows® service Oracle® Listener may not have been started automatically. To start this 
service manually, follow these steps: 

1. Press the Windows key, type in „Services“ 
and press Enter. 

 

2. Select “OracleOraDB18Home1TNSListener” 
and click Start. 

 
3. Close and restart MetIDQ™. 

 
If the Oracle® Listener was not started during the MetIDQ™ installation, the required 
import of the “metkit” database may have failed. Please proceed with the next issue. 

 

4. Configure Oracle® for MetIDQ™ - run “import_metkit.bat” 
If the Oracle® Listener was not started during the MetIDQ™ installation, the required import of 
the “metkit” database may have failed. To perform the import, please do the following steps. 

Step Do this 

1 
Find the “import_metkit.bat” file on the USB stick. 
 folder “MetIDQ and Oracle\Installation Files” 

 

2 
Right click on the “import_metkit.bat” file and select 
Run as administrator.  
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Step Do this 

3 

The database import window opens: 

 
Chose the Oracle® installation directory. By default, this is “C:\Oraclexe”. If Oracle is 
installed in another directory, enter the correct Oracle installation directory. 
Press Enter. 

4 
 

Enter the Oracle password you chose in section 2.1. 
Press Enter. 

5  
To confirm the settings type “y. 
Press Enter. 

6 The import process will begin. 

The import process may take several minutes. Wait until this message is displayed: 
“Installation of database backup feature completed! Press any key . . .“! 

 
7 When the import is complete, to close the window press any key. 

8 Close and restart MetIDQ™. 
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7.13 Create Analyst® Results of LC Data 
 

 

This issue applies only for clients using the Analyst® software. 
The described procedure replaces the export of LC results as an Analyst® result file (.rdb), 
described in the corresponding kit user manual. 

 

The LC data quantification procedure is described in the corresponding MxP® Quant 500, p180, 
Bile Acids, or Stero17 Kit user manual. After LC data quantification using the Analyst® software, 
export the results in a text-based file (.txt). 
 

Instructions Examples 

For results transfer to MetIDQ™, export the results: 

1. Right-click anywhere in the table and select Full. 

2. Select File > Export… 

3. Export the results as “Text Files (*.txt). 

 
This .txt file will be imported into MetIDQ™ (refer to 
MetIDQ™ user manual). 

  

1. 
 

2. 

 

3. 
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7.14 Abbreviations 
CSF cerebrospinal fluid 
EMA/EMEA European Medicines Agency 
FIA Flow Injection Analysis 
ISTD Internal Standard 
LC Liquid Chromatography 
LIMS Laboratory Information Management System 
LLOQ Lower Limit of Quantitation 
LOD Limit of Detection 
MS Mass Spectrometer 
OP Operation Procedure 
PBS Phosphate Buffered Saline 
PDF Portable Document Format 
QC Quality Control 
STD Standard 
ULOQ Upper Limit of Quantitation 
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7.15 Index
Analyte Concentration Graph 

content and description 99 
Analyte Overview Graph 

content and description 112 
Bar Codes 

Import bar codes 20 
Internal Standards 

in Analyte Overview Graph 112 
in Blank Well Graph 93 

Import Worklist 
feature description 32 

ISTD Graph (blank well) 
content and description 93 

ISTD Graph (other wells) 
content and description 94 

MetCONC 
module definition 67 
import MS data 67 

MetLIMS 
module definition 28 
defining groups and variables 135 
import sample information 42 
register samples (manually) 39 
register the assay 28 

MetSTAT 
module definition 115 
assay reports 128 
report formats 128 
time-dependent charts 128 

MetVAL 
module definition 93 
ISTD graphs 93, 94 
Standards graph 95 
QC graphs 96, 98 

Analyte graphs 99 
validation procedure 87 
EMEA validation 109 

OP 
definition 27 
load by patch file 27 

Oracle® 
install (XE version) 11 

Oracle® Database 
installation (metkit database) 13 

Plate Production Number 
enter MetLIMS 57 

Plate Report 
description and picture 27, 45 

QC Concentration Graph 
content and description 96 

QC Samples 
accuracy 95, 96, 98 
link QC samples 53 
replicates, distribute replicates 53 
position on plate 56 

Sample(s) 
import sample information 42 
link to worklist 45 
position on plate 56 
register samples (manually) 39 

Standards Graph 
content and description 95 

Upgrades 
Oracle® database 141 
software 141 
update existing plate to new OP 150 
load database patch 27 
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Worklist 
define, generate and approve 45 
Zero Sample(s) 
description and position on plate 52 
limits of detection (LOD) 88 
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Ordering and Technical Support 
 
Order AbsoluteIDQ® or Biocrates® Kits: 
 

E-Mail: Phone: 
sales@biocrates.com +43 512 579 823 

 
Technical assistance: 
 

E-Mail: Phone: 
support@biocrates.com Dr. Markus Langsdorf +43 676 848 434 214 
 Dr. Manuel Kratzke +43 676 848 434 105 
 Stephen Dearth, PhD +1 704 421 6512   (North America) 

 
Website: 

 http://www.biocrates.com 

 
Video Tutorials: 

 
https://www.youtube.com/playlist?list=PLGETE8vMY-
Plp_gSz4eMaSLG1QKB_mdFpk 

 
Frequently Asked Questions (FAQ): 

 
https://support.biocrates.com/tiki-index.php 

 

mailto:sales@biocrates.com
mailto:support@biocrates.com
http://www.biocrates.com/
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://support.biocrates.com/tiki-index.php
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